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1   Introduction 

Thank you for purchasing a Universal Devices, Inc. ISY Series device.  The ISY provides 

central control of home automation devices in a residence and is designed to play the role of 
home automation device controller in any domestic UPnP network.   

When properly accessorized, automation devices controlled by the ISY include: INSTEON 
lighting devices, ZigBee devices, Z-Wave devices, X10 lighting and power devices, relays, 
fans, curtain sweeps, thermostats, motion sensors, intruder alarms, power consumption 
monitors and many others.  ISY interfaces securely to both wireless and wire line local area 
networks and the internet. Controlled systems can be managed via a browser interface 
from any smartphone or other internet browser from any location with internet access. 
The user guide concentrates on INSTEON functionality in it’s examples.  Depending on your 
device’s options INSTEON may or may not be installed, however examples are 
interchangeable with other devices and protocols.  

With the ISY, you can: 

• Program, configure and manage your INSTEON, Z-Wave and X10 devices 
• Automate your home using sophisticated timers, triggers, and macros 
• Conserve energy in your home 
• Remotely control your home using the ISY’s web interface 
• And, MUCH more! 

This User Guide will help you install and configure your ISY and will provide links to 
additional resources that you may find helpful.  Please read through this guide before 
beginning installation. 

1.1   Lighting and Power Overview 

In order to make the most of the capabilities of the ISY, the user will find that a basic 
understanding of the devices to be controlled is helpful.  This section contains a review of the 
salient characteristics of the types of device that the ISY can control.  

When lights or power outlets are automated, the devices involved will almost always use Z-
Wave, INSTEON, or X10 protocols.  Such devices include light switches, power sockets, wired 
and remote controllers and IR receivers.  Although INSTEON or X10 protocols can coexist in the 
same device (often referred to as dual-band), the way each of the protocols operates is quite 
different.  The ISY controls both together so they can form a managed lighting solution that is 
simple to operate and easy to enhance. 
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Following is an overview of the INSTEON, Z-Wave and X10 protocols.  Please refer to 12  
Glossary for a detailed description of each of these protocols. 

INSTEON:  An integrated network protocol that combines wireless radio frequency (RF) 
with the home's existing electrical wiring.   This dual-mesh network approach means 
INSTEON is faster and more reliable than X10.  INSTEON is a peer-to-peer network - its 
devices do not require network supervision.  For straightforward applications an INSTEON 
network can operate effectively without a central controller. 

Z-Wave: is a wireless communications protocol designed for home automation, specifically to remotely 

control applications in residential and light commercial environments. The technology uses a low-power 
RF radio embedded or retrofitted into home electronics devices and systems, such as lighting, residential 
access control, entertainment systems and household appliances. 

X10:  A protocol that primarily uses power line wiring for signaling and control.  X10 switches 

operate by responding to the physical control (switch) on the device itself or by responding to an 

X10 control signal addressed to that switch from an X10 signal source elsewhere in the 

residence’s electrical system.  Typically, X10 devices are either controllers that generate X10 

signals or light switches or electrical sockets that respond to X10 signals.  Although, as a 

protocol, X10 lacks the capabilities and operational reliability of INSTEON, X10 switches 

remain the preferred way to control devices that may create surges at power-on such as 

traditional fluorescent lights and general-purpose electrical sockets. 

1.2   What's Included 

Depending on the package you purchased, you received at least the following:  

• ISY-994i Series device  
• Two (2) Standard Category 5e Ethernet patch cables 
• Quick Start guide 

1.3   Requirements & Recommendations 

In addition to the ISY package, the following are required: 

PowerLinc Modem (PLM):  a Smarthome 2412S (now discontinued) or 2413S is required 
to communicate to and from your INSTEON devices.  The 2413S can be purchased at 
Smarthome as follows:  http://www.smarthome.com/2413s.html 

A Java-enabled web browser (such as Internet Explorer or FireFox):  is required to 
launch the ISY’s Administrative Console.  The latest version of Java can be downloaded 
from:  http://www.java.com/getjava 

A DHCP-enabled router or other DHCP-enabled network:  is recommended for 
installation and configuration ease.  If using a non-DHCP-enabled router, or a direct 
connection to a computer that is not a DHCP server using an Ethernet cross-over cable (not 

http://en.wikipedia.org/wiki/Wireless
http://en.wikipedia.org/wiki/Home_automation
http://en.wikipedia.org/wiki/Lighting
http://en.wikipedia.org/wiki/Access_control
http://en.wikipedia.org/wiki/Household_appliance
http://www.smarthome.com/2413s.html
http://www.java.com/getjava
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included), you must have a micro USB cable and available USB port on your computer to 
configure the ISY's network parameters. 

1.4   The ISY Front Panel 

The ISY’s front panel has several elements with which you should become familiar:  

 

Figure 1: ISY Front Panel 

• The LEDs on the front of your unit show the current status of your ISY.  They can also 
assist with troubleshooting any issues you may be having.  For more information on the 
ISY’s front panel LEDs, please see Appendix A: Front and Rear Panel LEDs. 

• A Reset button is located on the front of your ISY.  To simply reboot your ISY, use a 
sharp object to briefly press the ISY’s recessed Reset Button.  To factory reset your ISY, 
please see Appendix B: Factory Reset. 

• Certain ISYs include an integrated IR receiver located on the front of the unit.  This IR 
receiver can be used to control your home using an RC-5-capable universal remote 
control. 

• Your ISY may also include an externally accessible SD card slot.  Please DO NOT 
remove the SD card while the ISY is running.  ISY’s without an external SD slot must be 
opened in order to replace the SD card.  For instructions on replacing your SD card, 
please see Appendix C: Upgrading Your SD Card. 
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1.5   The ISY Rear Panel 

The rear panel of the ISY features the following: 

 

Figure 2: ISY-994i Series Rear Panel 

The Power port is used to provide power to the ISY with an AC adapter.  This may not be 
necessary if using a 2412S PLM, but is required when using a 2413S PLM.  Please use an AC 
adapter that provides 5V DC, a minimum of 300mA, and is center terminal positive.   

Even if using a 2412S PLM, there are several reasons why you may want to use a separate 
AC adapter instead of power provided by the PLM: 

• An AC adapter can be plugged into a UPS to help protect the ISY from power outages 
and power surges.  The PLM cannot be plugged into a UPS. 

• Powering the ISY using a separate AC adapter may help improve (by a small amount) 
the signal strength of the INSTEON PLM. 

Port A is an RJ-45 connector used to attach your INSTEON PLM to the ISY.  This allows the 
ISY to communicate with your INSTEON devices.  Please use a standard Category 5e 
network patch cable (included) to connect your ISY to the PLM.  WARNING:  DO NOT use 
this port to connect to an Ethernet router or switch. 

The Monitor port is a micro USB port used for initial configuration for users without a 
DCHP-enabled network, or for advanced troubleshooting.  Please use a standard micro USB 
cable to connect your ISY to an available USB port on your PC.  

The Network jack is used to attach the ISY to your Ethernet network.  Use a standard 
Category 5e network patch cable (included) to plug your ISY into an available network jack 
on your router or switch.  If connecting directly to a PC for programming, please use an 
Ethernet cross-over cable (not included).  WARNING:  DO NOT use this port to connect to 
an INSTEON PLM. 
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2   Installation 

Installation of the ISY is completed in several easy steps.  The following instructions 
assume that you are installing the ISY on a DHCP-enabled network (true in the vast 
majority of cases) and are using a Windows-based PC to connect to the ISY. 

If you do not have a router or other DHCP-enabled network to plug the ISY into and plan on 
using a direct connection to a PC, or if you are using an OS other than Windows, please see 
our online Wiki for more advanced installation instructions:  http://wiki.universal-
devices.com  

2.1   Hardware Installation 

Installation of the ISY hardware is completed in three easy steps: 

1. Connect your ISY into your home network.  Plug one end of an included Ethernet cable 
into the ISY Network jack.  Plug the other end of the cable into your router or network 
switch/hub. 

2. Connect your ISY with the INSTEON PLM.  Plug one end of an included Ethernet cable 
into ISY Port A.  Plug the other end of the cable into your PLM. 

3. Apply power to the PLM and ISY by plugging it into a standard power outlet.  Do not 
plug the PLM into a UPS or surge protector of any kind.  If possible, avoid plugging the 
PLM into an outlet on the same circuit as other electronic devices to ensure optimal 
communications with your INSTEON devices.  For information on troubleshooting 
INSTEON communication issues, and tips on creating a reliable INSTEON network, see 
Appendix D: Troubleshooting INSTEON Communication Issues. 

Once power is supplied to your ISY, it automatically boots up.  The RX, TX, and Memory 
LEDs may flash briefly, and the POWER LED should be on steady.  The two small green 
LEDs on the ISY’s Network Jack should be on (indicating a good network connection) and 
may flash (indicating network activity).  Please refer to Appendix A: Front and Rear 
Panel LEDs for further details on the front panel. 

2.2   Connecting to the ISY from a Local PC – Launching Admin Console 

There are several requirements for connecting to your ISY from a PC on your network: 

• Web Browser:  Please ensure your PC is running a Java-enabled web browser, such as 
Internet Explorer or FireFox. 

http://wiki.universal-devices.com/
http://wiki.universal-devices.com/
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• Java:  Please ensure that the latest edition of Java is installed on your computer. The 
latest Java downloads may be found at:  http://www.java.com/getjava  

As shipped from the factory, the ISY is configured to obtain an IP address via DHCP.  There 
are a few easy ways to connect to your ISY and find its local URL: 

Option1:  In most cases, the quickest and easiest way to connect to the ISY for the first time 
on a Windows PC is to open a web browser and type in the following URL:  http://isy. If you 
have a MAC, please use Option 2. 

Option 2:  Install ISY Finder/Launcher on your desktop by following these instructions. 
The icon allows you to get to the Admin Console without the need for a browser.  If you 
have MAC Yosemite and Java 1.8.40, please do make sure to follow the instructions here. 

Once you see the ISY Finder/Launcher dialog, click on your ISY and then choose Admin 
Console (Figure 3a). 

 

 

Figure 3a: ISY Finder/Launcher 

 

Once you launch the Administrative Console, you will be presented with a login window 
asking you to authenticate your ISY.  The default login information is: 

Username:  admin 
Password:  admin 

http://www.java.com/getjava
http://isy/
https://wiki.universal-devices.com/index.php?title=Main_Page#Installing_the_Admin_Console_Icon_on_Your_Desktop
http://wiki.universal-devices.com/index.php?title=Troubleshooting_Help#MAC_OSX
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Figure 4b: Login Window 

Please refer to 3.1.1  Setting the User ID and Password to change these values. 

 

To find your ISY’s login URL, click the HELP -> ABOUT pull down menu: 

 

Figure 5: Help/About Menu 

Then look for the address listed after “My URL.” 

 

Figure 6: My URL 

Type this into your web browser to quickly connect to your ISY in the future.  Feel free to 
add this URL to your web browser’s Favorites. 

http://www.universal-devices.com/mwiki/index.php?title=File:QSG_Authenticate.gif
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When using DHCP, in some cases your ISY may receive a new IP address from your router 
(or other DHCP server).  If this happens, you may not be able to use the old address to 
connect to your ISY.  To find your ISY’s new address, simply double-click your My Lighting 
icon or visit the following URL to automatically find the ISY (and its new address) on your 
network:  http://isy.universal...com/994i/4.2.30 

If you wish to assign your ISY a static IP address, please see Appendix E: Assigning a 
Static IP Address to the ISY. 

Once you find your URL, you are ready to start using the ISY.  To connect to the ISY, launch 
your web browser and type the URL into the address bar.  You will then be asked to 
authenticate.  Again, the default login information is: 

Username:  admin 
Password:  admin 

Once you login you will be presented with the ISY’s HTML interface. 

2.3   The HTML Interface 

The ISY’s HTML interface provides an easy way to interact with your ISY.  The HTML 
interface does not require Java, and is accessible from just about any web browser – 
including mobile phones and other devices!   

http://isy.universal-devices.com/994i/4.2.30
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Figure 7: ISY’s Home Tab 

You won’t be able to do much until you start configuring your ISY, but here is a summary of 
what you can do with the HTML Interface: 

Home Tab: 

My Devices & Scenes – This is where you will find a list of all INSTEON devices and scenes 
you have on your ISY.  You can control your devices and scenes as well as check their 
current state.  Use this page to turn lights and other devices on or off, adjust your 
thermostats, and much more.   

My Devices – Same as My Devices and Scenes, but this shows only your devices.   

My Scenes – Same as My Devices & Scenes, but this shows only your scenes.  You will 
learn more about Scenes in the section entitled 3  The Administrative Console.   

My Weather (only available if the optional Climate Module has been installed on your 
ISY) – This item is where you can see weather information available to your ISY.  More 
information is available in the section entitled 3.9.2  Climate Module. 
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My Programs – By clicking this item you can view the status of any Programs you have 
stored on your ISY and also control them.  You will learn more about Programs in the 
section entitled 3.3  The Programs/Details Tab. 

Networking Resources (only available if the optional Network Resources Module has 
been installed on your ISY) – This section is where you can view and control any network 
resources you may have configured on your ISY.  More information is available in the 
section entitled 3.9.1   Network Module. 

Networking WOL (only available if the optional Network Resources Module has been 
installed on your ISY) – This section is where you can view and control any Wake-On-LAN 
entries you may have configured on your ISY.  More information is available in the section 
entitled 3.9.1   Network Module. 

Cameras– This section is where you can add and view network bases IP cameras. 

Elk (only available if the optional ELK Security Module has been installed on your 
ISY) – This section is where you can view and control any resources available from your 
ELK security system.  More information is available in the section entitled 3.9.5   ELK 
Security Module.   

Variables – This section is where you can view and control any Variables you have 
configured on your ISY.  More information is available in the section entitled 3.5   
Variables. 

Settings tab: 

SubDevices – This option allows you to show or hide SubDevices.  SubDevices are typically 
secondary buttons, such as non-load controlling buttons on KeypadLincs, etc. 

Controllers  – This option allows you to show or hide Controller-only devices, such as 
RemoteLincs and ControlLincs. 

Disabled – This option allows you to show or hide disabled devices.  Devices can be 
disabled through the Admin Console, refer to 3.2.6  Other Functions (Restore, Disable, 
Query, etc.) for further details. 

Max Width – This option sets the width of the HTML interface. 

Local Caching – Enabling this option tells the HTML interface to cache the node list to your 
system, potentially improving performance.  If this option is enabled, however, you will 
need to periodically hit Clear Cache (see below) to refresh the interface and see changes to 
your node list. 
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Clear Cache – This button clears the disk and memory cache of the HTML interface 
allowing you to see the latest changes to your node list. 

Install Admin Console – This button installs a local copy of the Admin Console applet to 
your system, creating a desktop icon so you can launch the Admin Console quickly and 
easily. 

Admin Console tab: 

Launches the ISY’s Administrative Console (requires Java).  The Administrative Console is 
where you will configure your ISY - adding devices, creating Programs, configuring the 
optional IR interface, and MUCH more.  

There may be other items available in the HTML interface depending on how your ISY is 
configured, and what optional modules you have purchased.   

3   The Administrative Console 

The Administrative Console is divided into several tabs, each used to configure different 
aspects of your ISY.  This section provides information to help you take advantage of the 
powerful features of the ISY Administrative Console.  There are, however, enhancements to 
the user interface too detailed to include in this section – please refer to Appendix F: User 
Enhancement Details for a description of these enhancements. 

The ISY’s Administrative Console automatically checks for the latest firmware release.  
When a new release is detected, the ISY provides a notification message and instructions on 
how to perform the update.  In some cases, however, you may want to manually download 
and install a different firmware release.  For example, some beta releases may contain 
important features or device support that you may want to utilize.  The Administrative 
Console will not notify you of beta firmware releases.  Please refer to Appendix G: 
Manually Upgrading Your Firmware for instructions on how to manually install a 
release. 

3.1   Basic Configuration  

Before getting started, it’s important to configure a few basic items on the ISY. 

3.1.1   Setting the User ID and Password 

For security reasons, please change the default User ID and Password used to connect to 
your ISY.  Choose the Set Userid/Password option with the Administrative Console’s File 
pull-down menu as shown below. 
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Figure 8: File Menu/ Set User ID/Password 

When choosing your new User ID and Password, please consider the following: 

• Both the User ID and Password must be entered 
• Both the User ID and Password are case sensitive 
• Both the User ID and Password must be between 3 and 10 characters 
• The following characters are NOT allowed:  < > / ; & 

3.1.2   Setting the Time and Location 

Click the ISY’s Configuration tab, then the System sub-tab, to set your time (used for 
Program schedules) and location (used to calculate sunrise/sunset times).   

 

Figure 9: Setting the Clock 

Please be sure to check the Daylight Saving option if applicable in your area.   

Also feel free to check and configure the NTP Server option if your ISY is able to access the 
internet.  The ISY periodically syncs its clock with the specified NTP server to ensure 
accurate time.  We recommend syncing every 24 hours, as too frequent connection 
attempts can result in the NTP server refusing the ISY’s request. 
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After adjusting your settings, please be sure to hit the Save button. 

3.1.3   Keyboard Navigation 

Please note that pull-down menus are accessible via keyboard shortcuts as follows: 

• Alt-F to access the File menu 
• Alt-L to access the Link Management menu 
• Alt-T to access the Tools menu 
• Alt-H to access the Help menu 

Once a pull-down menu is opened, use your Arrow keys to navigate and the Enter key to 
select a menu item.  You can also enter letter keys to access many menu items quickly – 
look for menu items that contain underlined letters.  For example, within the File pull-
down menu, enter “b” to open the Backup ISY dialog box. 

3.1.4   Themes 

You can choose among several predefined color schemes to suit your preference.  To select 
a different theme click the File pull-down menu, then Themes, then Theme Color and 
choose your scheme.  Please note that the Administrative Console must be closed and re-
opened for your Theme change to take effect.   

 

Figure 10: Change Theme Menu 
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Desert Grey 

  

High Contrast Default 

  

Figure 11: Theme Samples 

3.2   The Main Tab 

The Main tab is where you can add, configure, and manage your INSTEON devices.   
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Figure 12: The Main Tab 

The left-hand pane displays a hierarchy of folders, devices, and scenes contained within 
your ISY.  The right-hand pane displays detailed information on the item you have selected. 

3.2.1   Adding INSTEON Devices 

Adding INSTEON devices to the ISY can be done via several methods.  Some devices require 
a specific method; other devices can be added to the ISY in multiple ways.  For more 
detailed information, see Appendix H: INSTEON Device Notes. 

Adding devices to the ISY is done through the Link Management pull-down menu.  Within 
that menu are several different options: 
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Figure 13: The Link Management Menu 

Start Linking.  The majority of INSTEON devices can be added using this method.  Once 
this option is selected, simply go to each INSTEON device to be controlled and hold the Set 
button for 3-5 seconds.  The ISY will then see each device, and add it to the device list.  
When you hold the Set button on each device, the device is added to the left-hand pane.  
Adding devices to the ISY can take anywhere from a few seconds to minutes per device, 
depending on how many existing links are contained within each device.  Please be patient. 

Once you are finished adding devices, hit the Finish button which completes the process.  
Before adding devices to the ISY, it’s important to understand the 3 different options 
presented: 

 

Figure 14: Linking Options 

http://www.universal-devices.com/mwiki/index.php?title=File:QSG_Linking_In_Progress.gif
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• Remove existing links.  This option adds the device to the ISY, and also removes any 
existing links in the device.  This is the default and the best option to choose if you 
would like a clean start, or if it is a brand new device. 

• Add devices found in links and remove existing links.  This option not only adds the 
device, but also adds any devices that the device is linked to.  Once complete, it removes 
any links contained within the devices.  This helps save some time if you have a device 
you have already linked with other devices, but still clears out all links to give you a 
fresh start. 

• Add devices found in links and keep existing links.  This option not only adds the 
device, but also adds any devices that device is linked to.  It also keeps any pre-existing 
links between devices, and builds ISY scenes out of those links.  This is the best option 
to choose if you’d like to preserve all existing links between devices. 

• Link a ControLinc 

• Link a RemoteLinc 

• Add Button to IRLinc Receiver/Transmitter 

• Add Sensor to EZSnSRF  

• Add X10 Device to EZX10RF 

The above 5 options are used to add the respective devices to the ISY.  If you are adding one 
of these devices to the ISY, choose the corresponding menu option and follow the on-screen 
instructions. 

• Advanced Options.  This option adjusts the method used when the ISY is programming 
your devices.  Please do not use this option unless instructed by UDI support staff. 

• New INSTEON Device.  This method works much like the Start Linking method, with 
one exception – instead of pressing the SET button on each device you must type in the 
device’s INSTEON address.  The ISY then initiates communications with the device to 
add it to your system.  In most cases you can leave the Device Type option set to Auto 
Discover, but some devices may require you to specify the Device Type.  For more 
information please see:  Appendix H: INSTEON Device Notes. 

NOTE:  This option is entitled New INSTEON/X10/A10 Device if the optional X10 
Module is installed.  Please see 3.9.6   X10 Module for more information. 
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Figure 15: New INSTEON/A10/X10 Screen 

3.2.2   Adjusting Settings on INSTEON Devices 

Some INSTEON devices have settings that can be changed through the ISY.  For example, 
dimmable devices have On Levels (brightness levels when turned on) and Ramp Rates 
(speed at which a device is turned on) that can be adjusted.   

To adjust settings on a device, simply click to select a device.  Available settings will be 
displayed in the right-hand pane. 

Some devices may have other options available.  To find out more information for a 
particular device, please see Appendix H: INSTEON Device Notes. 

Making changes to INSTEON devices, whether adjusting settings or creating/modifying 
Scenes (see 3.2.3   Creating INSTEON Scenes), can be a time consuming process.  While 
making minor changes can be relatively quick, making changes to large scenes (for 
example) can take many minutes. 

PRO Series ONLY: 

By default, the ISY is set to automatically write updates to devices as you make changes in 
the Admin Console.  In some cases, you might prefer to queue your changes and write all 
changes to devices at a more convenient time.  Therefore the PRO Series provides the 
option to either write automatically or manually. 
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To toggle this option, click the File menu: 

 

Figure 16: File/Automatic Writes Options 

Automatic Writes to Devices:  When this option is on, changes are written automatically 
to devices.  Toggle this option off to disable automatic writes.  When toggled back on, all 
pending changes will be sent to devices. 

Automatic Writes to Battery Powered Devices.  This option toggles automatic writes 
only for battery powered devices.  Most battery powered devices need to be manually set 
to linking mode to accept changes, so utilizing this option to queue up  multiple changes 
can help save time. 

Devices that have pending changes waiting to be written are marked with a green icon in 
the device tree as pictured here: 

 

Figure 17: Devices with Pending Changes 
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To write all pending changes for a single device (without turning Automatic Writes back 
on), simply right-click the device and choose Write Updates to Device: 

 

Figure 18:  Write Updates to Device Screen 

3.2.3   Creating INSTEON Scenes 

Scenes are collections of INSTEON devices that react to and with one another in various 
ways.  Scenes are comprised of both Responders and Controllers. 

Responders are devices contained within scenes that only respond to commands issued to 
the scene.  For example, a lamp module with a table lamp attached would likely be a 
Responder to the scene.  When the scene is turned on, the lamp module would turn on.  
When the scene is turned off, the map module would turn off.  Responders are colored blue 
within a scene. 

Controllers not only respond to commands issued to the scene, they also control the scene.  
An example of a Controller might be a button located on a Keypad – when that Keypad 
button is pressed, all members of the scene will respond as configured.  Controllers are 
colored red within a scene. 
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To create a Scene, simply click the New Scene option under the Link Management pull-
down menu, or click the New Scene button on the ISY’s toolbar. 

 

Figure 19: New Scene Screen 

Name the Scene accordingly, click Ok, and your Scene appears in the left-hand pane.   

To add devices to a scene, simply right-click a device, choose Add to Scene…, and choose 
the appropriate Scene.  You can also hold the CTRL key down, click multiple devices, then 
right-click and choose Add to Scene… to add multiple devices at once. 

 

Figure 20: Choose Scene Screen 

If appropriate, the ISY asks you if the device should be added to the Scene as a Responder 
or a Controller.  Some devices (typically devices without buttons) cannot be Controllers. 

To remove devices from a Scene, simply right-click a device in a Scene and choose Remove 
from Scene.  To remove an entire Scene, simply right-click the scene and choose Remove 
Scene. 
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One example of a scene might be a group of 2 devices that control the same light – typically 
called a “virtual 3-way circuit.”  For example, you might have 2 switches in your kitchen 
that you’d like to control your kitchen table light.  One switch is physically attached to the 
kitchen table light, but you’d like the other switch to control it as well.  In this case you 
would add both devices as Controllers.  In the scene below, both devices in the scene are 
Controllers (shown below in red).  This is commonly called “cross-linking.” 

 

Figure 21: Cross-Linking 

Another example of a scene might be a keypad button that you want to control multiple 
lights in a room.  When the keypad button is turned on, you might want multiple devices to 
turn on at various levels to create a lighting “mood.”  When the keypad button is turned off, 
the devices would all turn off.  In the screenshot below, the KitchenDinner scene contains 
multiple Responder devices (in blue) with a single Controller (in red): 

 

Figure 22: Multiple Responders with 1 Controller 

Scenes can contain multiple Controllers, and each Controller can be programmed to set 
Responders to various On Levels and Ramp Rates. 

On Levels are levels at which a Responder is turned on when activated (25%, 75%, etc.).  
Devices can have multiple On Levels (one per Controller).  Relay devices can only be On or 
Off. 

Ramp Rates (dimmable devices only) are the speeds at which a device is turned on when 
activated.  Use a slower ramp rate to cause a light to start dim and get brighter slowly. 

To set the properties of a scene, click on a Controller within a scene.  The right-hand pane 
contains the options to set each scene member’s On Levels and Ramp Rates used when the 
highlighted Controller is pressed.  Simply move the appropriate slider left or right to adjust 
the values.  Once the slider is released, changes are saved to the device. 
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To set values when the ISY itself is the Controller (for example when controlled through the 
Administrative Console or through ISY Programs), click the scene itself on the left-hand 
pane. 

In the example below, when the highlighted Controller is pressed the TheaterControls1A-
Table device turns on to 60% and the TheaterMain1 and TheaterMain2 devices turn off.  All 
devices are set to use a 2 second Ramp Rate. 

 

Figure 23: Controller Properties 

There are a couple of other options available when adjusting scenes: 

Apply Changes To All Devices.  This option merges all Responder sliders to one slider to 
make bulk changes easier.  For example, if you want all responders in a scene to turn on to 
50%, simply check the Apply Changes To All Devices option and drag the single slider to 
50%. 

Copy Scene Attributes From...  As noted above, the ISY itself is also a Controller of every 
scene.  If a Controller within a scene should use the same values the ISY uses when 
controlling a scene, simply click this button to copy the values from the ISY over to the 
currently selected Controller. 

NOTE:  Once programmed, scenes operate independently of the ISY – all programming is 
saved to the INSTEON devices.  If the ISY is turned off or is offline for some reason, 
programmed Scenes still operate as expected. 

NOTE:  It’s important that all links between devices are created from within the ISY.  Avoid 
creating links manually between devices or using other software packages – unexpected 
results will occur. 

3.2.4   Organizing INSTEON Devices and Scenes 

Once added to your ISY, you can manage and organize your INSTEON Devices and Scenes in 
a variety of ways: 
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Rename.  When added to the ISY, devices are named their INSTEON address by default.  If 
you right-click a device or scene, a Rename option is available to help make your devices 
more identifiable.  You can also rename by left-clicking to highlight, then hitting the F2 key.  
A dialog box pops up giving you several rename options if you’d like to rename associated 
devices as well. 

Folders.  Feel free to create folders to help organize your Devices and Scenes.  Folders can 
be created by either right-clicking on the Network node (located on the left-hand pane) and 
choosing New Folder, or using the New Folder icon located on the Administrative Console’s 
top toolbar.  Devices and Scenes can be dragged and dropped onto folders, or simply right-
click a Device or Scene and choose Move To Folder and select the appropriate folder to 
move it to.  Folders can also be moved within other Folders to create a nested hierarchy. 

Delete.  By deleting a Device or Scene you remove it completely from the ISY.  The ISY also 
removes any links associated with any other Device or Scene. 

NOTE:  In order to delete a Device or Scene entirely from the node list, it must be located in 
the parent “My Lighting” folder.  So, to delete a node, be sure to move it out to “My Lighting” 
first. 

My Lighting.  Clicking the My Lighting node on the left-hand pane displays a summary of 
all your devices, their current states, their INSTEON addresses, their device types and their 
firmware versions.  You can sort by any field simply by clicking the appropriate column 
header (Name, Current State, Address, or Type). 

3.2.5   Controlling INSTEON Devices and Scenes 

The Admin Console also allows you to control your INSTEON devices and scenes.  Simply 
click on a device or scene, and appropriate controls display on the bottom of the Console as 
follows: 

 

Figure 24: Scene Controls 

On.  Clicking this button turns the INSTEON device or scene on to its programmed On Level 
using its programmed Ramp Rate. 

Off.  Clicking this button turns the INSTEON device or scene off using it’s programmed 
Ramp Rate. 
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Fast On.  Clicking this button turns the INSTEON device or scene on to its maximum 
(100%) level instantly (ignoring its programmed On Level and Ramp Rate). 

Fast Off.  Clicking this button turns the INSTEON device or scene off instantly (ignoring its 
programmed Ramp Rate). 

Brighten.  Pressing and holding this button starts ramping up the brightness level of a 
dimmable INSTEON device.  Release the button to stop the ramp up. 

Dim. Pressing and holding this button starts ramping down the brightness level of a 
dimmable INSTEON device.  Release the button to stop the ramp down. 

LED Brightness.  Some INSTEON devices allow you to adjust the brightness of their LEDs 
by changing this value. 

Some devices may have other controls or options available.  To find out more information 
for a particular device, please see Appendix H: INSTEON Device Notes. 

3.2.6   Other Functions (Restore, Disable, Query, etc.) 

There are several other functions available when working with INSTEON devices in the 
Administrative Console’s Main tab.  These functions are available by right-clicking the 
device or Scene. 

Restore Device.  If an INSTEON device has lost all or some of its configuration, you can try 
using this function.  This will attempt to re-write all links in a device, recreating all scenes 
to match the ISY’s internal database.  Because a device restore can be a very lengthy 
process the ISY provides a confirmation window to avoid accidental restores as shown 
below: 

 

Figure 25: Restore Confirmation Window 

Disable.  If an INSTEON device will be taken offline for an extended period of time, it might 
be desirable to use this function to stop the ISY from trying to access it.   
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Query.  This function causes the ISY to communicate with the highlighted Device or 
Devices to determine their current states. 

Group Devices.  Some INSTEON devices create multiple entries within the ISY.  For 
example, KeypadLincs have 6 or 8 nodes in the ISY (one for each button).  You can choose 
to group these nodes together by right-clicking the primary node and using this function. 

Write Updates to Device.  If you have turned off “Automatic Writes to Devices” or 
“Automatic Writes to Battery Powered Devices” you can manually update a Device with any 
pending changes using this function. 

3.3   The Programs/Details Tab 

The Programs/Details tab is where you can create ISY Programs.  ISY Programs are the 
true power of the ISY, where you can extend the capabilities of INSTEON and other devices 
using timers, triggers, macros, etc.  Programs also allow you to utilize the ISY’s optional IR 
receiver, optional modules, and more. 

To open this tab, first click the Programs tab, then click the Details sub-tab.  The 
Programs/Details screen is divided into several sections.  The left-pane is used to show 
your program hierarchy.  As you create ISY programs and folders, they display here.  The 
bottom-left “Manage Programs” section holds several buttons used to create and manage 
your Programs. 

The top-right portion of the screen shows the details of a highlighted folder or program.  
The bottom right is where you create and edit your Program. 

3.3.1   The Basics of ISY Programs 

ISY Programs are created using simple buttons and pull-down menus.  The ISY allows you 
to easily create simple programs, yet is flexible and sophisticated enough to allow powerful 
and complex programming. 

NOTE:  Unlike Scenes, Programs require that the ISY is online in order to function.  

There are several buttons available on the bottom-left of the Administrative Console used 
to create and manage your Programs: 

New Program.  This button creates a new ISY Program.  Once a Program is created, it can 
be edited and modified as needed. 

New Folder.  This button creates a new folder in your Program hierarchy. 
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Save Changes.  The ISY requires that you save your changes before they become active.  
Please be sure to save periodically as you create and edit your ISY Programs.  

Undo Changes.  If you have made changes to your ISY Programs that you would like to 
discard, click this button that causes the ISY to revert to the last time your changes were 
saved. 

3.3.2   Creating Your First Program 

To create a Program click the New Program button and a new program appears.   

 

Figure 26: Creating a Program 

The ISY prompts you to name your program – type in something descriptive so you can 
easily identify it in the future. 

 

Figure 27: Naming a Program 

Once you name your program click the If statement to set your conditions. 

 

Figure 28: If Statement 

Once highlighted, the bottom portion of the screen allows you to set your conditions using 
simple buttons and pull-down menus.  For this example, we will create a program to turn 
your front door lights on at sunset. 

To set your sunset condition, click the Schedule button and change the right-most drop 
down menu to Sunset as shown below. 
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Figure 29: Schedule at Sunset 

Once your Sunset condition is set, click Add to ‘If’ and you will see the If statement added 
to the top portion of the screen, which shows the actual program you are creating. 

 

Figure 30: Adding to the If Statement 

Next, click on the Then statement to highlight it.  The Then portion of a program runs once 
the If portion of a program is true.  At the bottom of the screen choose the device or scene 
that you want to turn on at sunset. 
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Figure 31: Adding a Then Statement 

This time hit the Add to ‘Then’ button to add the Then statement to your program. 

 

Figure 32: Entering a Then Statement 

Hit the Save Changes button to save your program, and you’re done!  In just a few steps 
we’ve created a simple program to turn on your front door lights at sunset. 

But, let’s say we wanted something slightly more sophisticated.  Say we want to turn the 
lights on 30 minutes AFTER sunset, and turn them off at 10pm.  To do that, we’ll make a 
couple of quick adjustments to the program. 

First we’ll click the “Time is Sunset” IF statement to highlight it.   
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Figure 33: Changing the If Statement 

Once the statement is highlighted we can edit it on the bottom of the screen.  Change the 
Time Is pull-down menu to a From and change the middle numeric value to 30.  Then 
change the For pull-down menu to To and change the values to 10pm as shown below: 

 

Figure 34: Updating the Schedule 

Click the Update button to change the highlighted statement.  Clicking the Add to ‘If’ 
button would add an additional IF statement, which is not what we want to do in this case. 

The ELSE portion of a program runs once the IF statement is no longer true.  After 10pm 
the IF statement is no longer true, so the ELSE statement runs.  Next click the ELSE 
statement on the top portion of the screen to highlight it, and on the bottom portion set 
your Front Door lights to turn off. 
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Figure 35: Adding an Else Statement 

Click Add to ‘Else’ and your final program should look like this: 

 

Figure 36: Enhanced Sample Program 

Hit the Save Changes button in the bottom left, and your enhanced program is complete! 

NOTE:  Always remember to hit the Save Changes button when finished creating or editing 
your programs!  Changes are not saved to the ISY until this button is pressed. 

There is virtually an unlimited number of functions you can perform using ISY programs.  
For more examples, see Appendix I: Sample ISY Programs. 

3.3.3   Building Your Programs 

There are a variety of on-screen buttons to help build your Programs to suit your needs.  
Programs are not limited to one condition or action – you can add multiple IF, THEN, and 
ELSE statements to your program.  When adding multiple lines, be sure to choose AND or 
OR as appropriate.   
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When working with Programs containing multiple lines, additional buttons appear to help 
arrange your lines and group them together with parentheses.   

 

Figure 37: Additional Program Buttons 

To remove a line, simply highlight it and click Remove Line.  To rearrange your lines, 
highlight them and click Move Line Up or Move Line Down. 

To group conditions together, use the Add And (..) and Add Or (..) buttons as shown 
below: 

 

Figure 38: Grouping Conditions 

This program executes only if the time is 9:45pm and the BasementControls1A device is On 
or if the time is 10:00pm and the BasementControls1A device is Off. 

Click the Comment button to add comments to your program as needed.  Click the Update 
button to save your comment. 
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Figure 39: Adding Program Comments 

To temporarily disable a program, un-check the Enabled box on the right-hand side of the 
screen and hit the Save Changes button.  Alternatively, simply right-click a program and 
choose Disable.   

 

Figure 40: Temporarily Disable a Program 

Disabled programs are displayed with a red X in the Program list as shown below: 

 

Figure 41: Disabled Programs 

Programs that have changes and need to be saved are displayed in the program list with a 
green arrow: 
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Figure 42: Unsaved Programs with Changes 

3.3.4   Program Schedules 

In the Add To Program button section, click Schedule to add a Schedule to your Program.   

Schedules allow you to add IF statements based on time of day, ranges of times, 
sunrise/sunset, days of the week, etc. 

For example, a program that would run from 6am to 12pm: 

 

Figure 43: Schedule Screen – Time Range 
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Or a program that would run at 10pm on weekdays: 

 

Figure 44: Schedule Screen – Time & Day 

Once your Schedule statement is complete, click the Add to ‘If’ button to add it to your 
program. 

3.3.5   Program Conditions 

In the Add To Program button section, click Condition to add a Condition to your 
Program.   

Conditions add other criteria to your IF statement.  When adding a Condition to your 
Program, be sure to choose if you would like it to be added as an AND or OR. 

Types of Conditions are: 

Status conditions are true if a selected INSTEON device is at the state you specify.  You can 
check to see if a device is On, Off, is Not On, is Not Off; if a dimmable device is at a specific 
level, if it’s greater than a specific level, etc.   

On means a device is at 100% brightness.  So, if your program is checking to see if a 
dimmable device is on at ANY level, select Not Off instead. 
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For example, to see if your kitchen light is at 100% brightness you could do the following: 

 

Figure 45: Status Condition – 100% Bright 

But, to see if the same light is on at ANY brightness you might do this instead: 

 

Figure 46: Status Condition – Any Brightness 

Control conditions trigger only if a specified switch is pressed.  The following types of 
conditions are available (not all options are available for all devices): 

On 

Off  

Fast On (double-tap ON) 

Fast Off (double-tap OFF) 

Fade Up (press and hold ON) 

Fade Down (press and hold OFF) 

Fade Stop (release of a press and hold) 

Bright (bright button pressed) 

Dim (dim button pressed) 

For example if you want to trigger a program if your Kitchen switch is double-tapped ON 
(Fast On) you could do the following: 
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Figure 47: Fast On Condition 

Program Conditions check to see whether or not other ISY Programs are currently True or 
False.  

X10 Conditions trigger programs when X10 commands are received by the ISY.  For 
example, to run a program if an X10 M1 ON command is received: 

 

Figure 48: X10 Condition 

Variable Conditions trigger programs based on the value of a defined variable.  You can 
read more about Variables in 3.5   Variables. 

IR Conditions trigger programs when IR commands are received from a remote control.  
See 3.5   Variables for more information. 

Module Conditions trigger programs based on optional ISY modules, such as the Electricity 
meter module or the Climate module.  See 3.9   Optional Modules for more information.  

ELK conditions trigger programs based on the state of available ELK resources, assuming 
you have an ELK security system installed and communicating with your ISY, and have the 
optional ELK Security System module installed.  See 3.9.5  ELK Security Module for more 
information. 

3.3.6   Program Actions 

In the Add To Program button section, click Action to add an Action to your Program.   

Program Actions are commands that are run when the IF statement is true (a THEN action) 
or if the IF statement is no longer true (an ELSE action).  When adding an Action to your 
program, be sure to click the Add to ‘Then’ or Add to ‘Else’ button depending on your 
intended result. 
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Insteon (Insteon/X10 with the optional X10 option):  Sends INSTEON commands to 
devices or scenes to turn them ON, OFF, etc.  Not all options are available for all devices: 

ON (send a standard ON command) 

OFF (send a standard OFF command) 

FAST ON (turn device full on ignoring programmed on level or ramp rate) 

FAST OFF (turn device full off ignoring programmed ramp rate) 

FADE UP (start the ramp up of a dimmable device 

FADE DOWN (start the ramp down of a dimmable device) 

FADE TOP (stop the ramping up or down of a dimmable device) 

BRIGHT (small increase in brightness of a dimmable device) 

DIM (small decrease in brightness of a dimmable device) 

QUERY (query the current state of a device) 

BEEP DURATION (causes a supported device or scene to emit a beep) 

BACKLIGHT LEVEL (sets the backlight level on a supported device) 

Send X10:  Sends X10 commands to X10-compatible devices.  Using this feature, ISY 
programs can control a wide range of X10-compatible devices. 

Notify:  Sends an email or SMS text message to recipients.  Please see 3.7  Notifications for 
more information. 

Program:  Runs or modifies other ISY programs.  The following options are available: 

Run (If) (runs the IF portion of a program) 

Run Then (runs the THEN portion of a program) 

Run Else (runs the ELSE portion of a program) 

Stop (stops a currently running program) 

Enable (enables a disabled program) 
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Disable (disables and enabled program) 

Enable Run at Startup (sets a program to run at startup) 

Disable Run at Startup (sets a program to NOT run at startup) 

Wait:  Creates a pause in a running program.  For example, to turn your driveway lights off 
5 minutes after your front door lights are turned off, you could do the following: 

 

Figure 49: Wait Action 

If the Random checkbox is checked, a random time between 0 and the specified time is 
used.  For example, this program would wait between 0 and 5 minutes: 

 

Figure 50: Random Action 

Repeat:  Repeats an action or group of actions multiple times.  If the Random button is 
checked, a random number of repeats between 0 and the specified value is used. 
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For example, to flash your driveway lights on and off 5 times, every 2 seconds, you could: 

 

Figure 51: Flash Lights ON and OFF 

Variable:  Allows you to adjust the value of a defined variable within program.  Please see 
3.5  Variables for more information. 

Adjust Scene:  Adjusts the On Levels and Ramp Rates of devices or scenes.  For example, 
use this function to adjust scenes so that they turn on at brighter levels during the day and 
perhaps at dimmer levels during the evening.  Please keep in mind that many devices 
require a reboot before On Level or Ramp Rate changes take effect, so this function may not 
be useful in all cases. 

System:  Notifies compatible clients of energy related alerts. 

Other Actions may be available depending on what optional modules you may have 
installed.  For more information, see 3.9   Optional Modules. 

3.3.7   Program Folders 

To create a new folder, simply click the New Folder button on the bottom-left corner of the 
screen.  You can also create new folders by right-clicking on the program hierarchy (left-
hand side of the screen) and choosing New Folder. 

Folders can be used to store Programs to help organize them by type, category, etc.   

Folders can also have conditions set on them to aid in program functionality.  For example, 
you could create a Vacation Programs folder that contains only programs that should run 
when you are on vacation.  In the following example, the user turns a keypad button called 
“GarageControls2E” on if they are going away on vacation.  The folder is set with the 
following conditions so that the contained programs run only if that vacation keypad 
button is on: 
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Figure 52: Folder Conditions 

To set conditions on a folder, simply click the folder to select it and adjust conditions as you 
would any ISY Program. 

3.3.8   Other Functions 

Status.  To quickly view the current status of a Program, simply right-click it and choose 
Status which brings you to the Program Summary tab with the selected program 
highlighted. 

Copy / Copy Tree.  To duplicate a program, simply right-click the Program and choose 
Copy.  This is especially useful if creating several similar Programs.  To duplicate a Folder 
and all contained Programs, right-click the Folder and choose Copy Tree. 

Import / Export.  Programs can be imported and exported to the ISY by right-clicking a 
Program or Folder and choosing the desired function. 

Find / Replace.  Right-click within your Program hierarchy to start a Fine / Replace.  This 
function allows you to search your programs for specific devices or text strings, and 
optionally replace the results.  

Copy To Clipboard.  To copy a specific Program as text to your clipboard, simply right-
click it and choose Copy To Clipboard.  The text can then be pasted into practically any 
Windows application, text editor, web browser, etc. 

Rename.  To rename a Program or Folder, simply right-click it and choose the Rename 
function. 

Remove.  To remove a Program or Folder (and all contained Programs), simply right-click 
it and choose Remove.  Remember to hit the SAVE CHANGES button when complete. 
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3.4   The Programs/Summary Tab 

The Programs/Summary page displays a list of all your Programs and Folders, and 
information about each.  To open this tab, first click the Programs tab, then the Summary 
sub-tab.  Here are the columns of information available: 

• Name:  the Program or Folder’s name. 
• Enabled:  shows whether the Program is currently enabled or disabled. 
• Run At Startup:  shows whether the Program is set to run at startup. 
• Activity:  shows if the Program is currently running or is idle. 
• Status:  shows if the Program’s IF statements are currently true or false. 
• Path:  the Folder that the program is located in. 
• Last Run Time:  the last time the Program’s IF statements were evaluated. 
• Last Finish Time:  the last time the Program completed. 
• Next Scheduled Run:  the next time the Program is scheduled to run, if applicable. 

Each column can be sorted by clicking its column heading. 

There is a toolbar on the top portion of the screen that you can use to interact with ISY 
programs in a variety of ways. 

 

Figure 53: ISY Toolbar 

To perform an action on a program, simply selecting it by clicking on it, click the left-most 
pull-down menu labeled “Choose” to select an action, and click the Apply button. 

Available actions are: 

Enable – enable a program that has been disabled 

Disable – disable a program so that it will not run 

Run (If) – force the evaluation of the IF statement and run the program 

Run Then – force the run of the THEN portion of a program 

Run Else – force the run of the ELSE portion of a program 

Stop – stop a currently running program 
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Enable Run At Startup – set a program so that it automatically starts running when the 
ISY reboots 

Disable Run At Startup – set a program so that it will not automatically run when the ISY 
reboots 

On the right-most side of the tool bar is the Edit button which brings you to the Program 
Details tab and allows you to edit the currently highlighted program.  The Refresh button 
forces a refresh of the screen. 

3.5   Variables 

Variables can be incredibly useful when creating programs on the ISY.  Variables can be 
stored, modified using arithmetic operations, and compared.  You can use variables to 
provide information, trigger programs, etc. 

To view your variables, click on the Programs tab then the Variables sub-tab.   

There are two different types of variables (Integer and State), each divided into a separate 
sub-tab. The only difference between the two is that State variables create ISY events when 
modified, so they can be used to trigger ISY Programs. 

For example, if you’d like to create an ISY Program that runs only when a variable is or 
reaches a certain value, use a State variable.  Otherwise, if the variable’s value will not be 
used to trigger a program, feel free to use the simpler Integer variable. 

3.5.1   Creating Variables 

To create a new variable, click the Add button on the bottom of the screen.  Here is a list of 
each column and a quick definition: 

Name – This is the user-defined name of the variable.  Choose a name that’s descriptive so 
that you’ll be able to quickly identify the variable you want to use in ISY Programs. 

Init – This is the initial value of the variable, the value it has if the ISY is rebooted.  This can 
be defined here and also updated using ISY Programs so that a variable value can persist 
even if the ISY loses power. 

Value – This is the current value of the variable.  Again, this can be defined here and also 
modified via arithmetic operations using ISY Programs. 

Last Changed – This displays the date and time that the variable was last modified. 
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3.5.2   Using the Status of Variables in Programs 

You can use the If portion of an ISY Program to check the state of a variable.  To do those, 
choose Variable when defining your If statement, then choose your Variable, then choose 
what you’d like to check for.  

For example, you can check to see if a Variable is a certain value, if it’s NOT a certain value, 
if it’s greater than a certain value, etc.  You can also compare one variable to another. 

In this screenshot we are checking to see if a Variable called Counter is greater than 3: 

 

Figure 54: Counter Variable 

3.5.3   Modifying Variables in Programs 

You can also use ISY Programs to modify variables.  You can perform standard arithmetic 
functions on a variable, change a variable to a specific value, or modify a variable’s Init 
state. 

The following functions can be performed on a variable: 

Command Function Performed 

= Sets the variable to a specified value. 

+= Adds to the variable 

-= Subtracts from the variable 

*= Multiples the variable 

/= Divides the variable 

%= Performs a remainder function on the variable 

&= Performs an AND (binary) function on the 
variable 

|= Performs an OR (binary) function on the 
variable 

=Random Sets the variable to a number between 1 and 
the specified number 

Init To Sets the variable’s initial value 

For example, the following screenshot increases a variable by 1: 
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Figure 55: Increment a Variable by 1 

This example sets the Init value of a variable to the current value of another variable: 

 

Figure 56: Set a Variable’s Initial Value 

3.5.4   Using Variables in Notifications 

Variables can also be useful when sending notifications.  Say you have a variable that you 
use to count the number of times a motion sensor is trigged overnight.  You could send 
yourself an email in the morning telling you how many times it was triggered. 

Your notification might look like this: 

 

Figure 57: Email Based on Motion Sensor Trigger 
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3.6   The Integrated IR Receiver 

If your ISY came equipped with an integrated IR receiver (model numbers that contain 
“/IR”), Programs can be triggered using an RC5-compatible remote control.  To program IR 
codes into the ISY, click the Configuration tab, then the IR sub-tab.   

The IR configuration page lists all IR codes currently recognized by the ISY.  The first 
column titled “Name” allows you to customize the name of a stored IR code.  Simply double-
click the IR code you’d like to change, and type the desired name.  This is how the IR code 
will be listed under ISY Program Conditions. 

The “IR Code” is an internal number used to identify the IR code.  It cannot be change and 
for the most part should be ignored. 

The “Status” column contains the last Condition received from a particular IR code.  The 
following conditions are available: 

Pressed – indicates the remote control button was pressed and released normally. 

Double-Pressed – indicates the remote control button was pressed twice quickly (similar 
to a mouse double-click). 

Held – indicates the remote control button was pressed and held (not yet released). 

Released – indicates the remote control button was pressed and held, then released. 

The above Conditions are available in ISY Programs, allowing you to control your home in a 
wide variety of ways from a simple remote control. 

There are also 3 buttons on the bottom of the IR Configuration Page: 

Save – this button saves the currently displayed IR codes to the ISY. 

Reload – this button aborts any IR codes learned since the last Save, and “reloads” the last 
saved IR database from the ISY. 

Restore Defaults – this button restores the ISY to its default, blank IR database. 

3.6.1   Using the 40 Default IR Codes 

The ISY is able to download 40 pre-configured IR codes.  These 40 pre-configured codes 
make it easier to configure remote controls that contain the ISY in their database (such as 
the Logitech Harmony), or remote controls that can import CCF files.   



 

 -  47  - 

To import these 40 pre-configured IR codes into your ISY, simply click the “Import Default 
IR Codes” button at the top of the screen.  This auto-populates the IR Configuration page 
with 40 codes labeled “IR_001, IR_002, etc.”  This overwrites any IR codes you may already 
have stored on your ISY.   

With Logitech Harmony remote controls, you can simply choose the Universal Devices ISY 
from the Harmony software’s built-in database.  The Harmony software allows you to drag 
and drop the ISY’s 40 default IR codes onto buttons on your remote control.   

If you’re using a Pronto or other CCF-compatible remote control, we have a CCF file 
available for download here:  http://www.universal-devices.com/ir/99/isy-99.ccf. 

If you’re using a Universal Remote Control (URC) brand remote, we have a MXJ file 
available for download here:  http://www.universal-devices.com/ir/99/isy-99.mxj. 

Once your remote control is configured, create Programs to have your ISY perform actions 
or a series of actions based on your remote’s button press.  IR codes stored on the ISY will 
be available as Conditions when creating ISY Programs. 

3.6.2   Using the IR Learning Mode 

If more than 40 IR codes are needed, or if you prefer to “teach” your own IR codes, the ISY 
features a learning mode that is capable of reading most codes sent from RC5 compatible 
remote controls.  For best results, try using codes compatible with Philips-brand devices, 
which are typically RC-5 compatible. 

To use the ISY’s learning mode, hit the button titled Enter Learning Mode.  The ISY now 
waits for IR codes, and once received they will be entered into the ISY’s IR database.  
Simply point your remote control at the front of the ISY and press the button you’d like the 
ISY to learn. 

If a button press is not recognized, or a button is not recognized as expected, please try a 
different button/code. 

Some symptoms of an incompatible IR code are: 

Multiple entries created from a single button press 

Inaccurate Status values (eg. you PRESS a button but the ISY shows it as HELD) 

We highly recommend testing an IR code well to ensure it is 100% reliable with the ISY 
before saving.  Make sure the ISY consistently displays the code correctly when the button 
is Pressed, Held, Released, etc. 

http://www.universal-devices.com/ir/99/isy-99.ccf
http://www.universal-devices.com/ir/99/isy-99.mxj
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When done teaching IR codes to your ISY, hit the “Leave Learning Mode” button on the top 
of the screen and be sure to “Save” your changes.  If you wish to revert to the last saved IR 
codes stored on your ISY, hit the “Reload” button located on the bottom of your screen. 

3.7   Notifications 

Using Programs, you can configure the ISY to send you notifications via text message or 
email.  For example, the ISY could notify you if your thermostat drops below or above a 
pre-defined temperature, when motion is detected in an area of your home, or when your 
garage door opens unexpectedly. 

3.7.1   Adding Recipients & Changing Server Settings 

To configure recipients of these notifications, click on the Administrative Console’s 
Configuration tab, choose the Emails/Notifications sub-tab, then the Settings/Groups tap 
below that. 

On the bottom portion of the screen, labeled Groups, hit the Add button to create a Group 
and add recipient information.  Simply name your group, then hit the field under the 
Recipient column to edit the recipients.  A group can contain one or more recipients that 
you would like to notify. 

 

Figure 58: Email Recipients Screen 
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Choose the type of recipient you’d like to add (Regular Email, text notification, etc.), hit the 
Add button, then type the recipients corresponding address as instructed.  When done, hit 
OK to finish editing the group.   

Always remember to hit the Save button on the bottom of the Admin Console to save 
your settings to the ISY. 

To send a test message to one of your recipient groups, highlight the group and hit the Test 
button on the bottom of your screen. 

On the top of the screen you’ll also find the “SMTP Settings” window where you can specify 
the email server used to deliver notifications.  If “Use Default” is checked, the ISY utilizes 
the Universal-Devices server to send out notifications. 

For advanced users, or if your ISP is blocking access to outside email servers, you can 
uncheck this box and specify a custom SMTP server to use. 

3.7.2   Custom Notifications  

To configure custom notifications, click the Customizations sub-tab and hit the Add button.  
Simply name your customization and type the message click the Customized Content field 
to edit the content you want to send with your notification. 

Use the drop-down boxes to add real time information to your notification, such as current 
time/date, variable values, security system information, weather conditions, etc. 

Once created, these custom notifications can be triggered and sent using your ISY 
Programs. 

Note that Custom Notifications supports plain text, HTML and XML. 

For example, you could set up a variable used to count how many times your motion sensor 
triggered every night.  In the morning, the ISY could email this information using the 
following notification: 
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Figure 59: Motion Sensor Email 

This program would send this notification to you every morning at 6am, then reset the 
variable back to 0: 

 

Figure 60: Scheduling an Email 

Here is a link to a page on the ISY wiki that details the available Email Substitution 
Variables: 

http://wiki.universal-devices.com/index.php?title=ISY-
99i_Series_INSTEON:Custom_Email_Substitution_Variables  

3.8   Interfacing with the ELK 

If you have an ELK M1 alarm/automation panel installed, it can be configured to 
communicate with the ISY.  Once communication is established, you can: 

http://wiki.universal-devices.com/index.php?title=ISY-99i_Series_INSTEON:Custom_Email_Substitution_Variables
http://wiki.universal-devices.com/index.php?title=ISY-99i_Series_INSTEON:Custom_Email_Substitution_Variables
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Arm/Disarm your ELK from the ISY’s web interface and Administrative Console 

Control Devices and Scenes stored on the ISY from your ELK (through ELK keypads, 
programs stored on the ELK, etc.) 

On the ELK side, you will need an ELK M1XEP which provides an Ethernet-interface for 
your ELK.  We highly recommend configuring your ELK with a static IP address (see your 
ELK documentation for instructions).  Using ELK’s ELKRP software, ensure that you enable 
the ELK’s “Non-Secure” port in the M1XEP setup. 

In the ISY’s Administrative Console, click the Configuration tab, then the ELK sub-tab, then 
the Configuration sub-tab.  This is where you can configure your ELK: 

 

Figure 61: ELK Configuration Screen 

Type your ELK’s IP address in the appropriate field, and enter your ELK’s Non-Secure Port 
(default is 2101).  Then enter your ELK’s RP Access code, and hit the SAVE button to save 
your settings and initiate communications. 

If successful, a “Security System” bar appears on the top of your Administrative Console 
showing you the current state of your ELK and allowing you to type your ELK’s security 
code and arm/disarm it: 

 

Figure 62: ELK Status Screen 

To allow control of your ISY-configured Devices and Scenes from the ELK, you must export 
your lighting information from the Administrative Console and import this file onto your 
ELK using ElkRP.  Hit the Export sub-tab to go to the Export screen.   
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The right-hand column lists all Devices and Scenes available for export to the ELK.  Simply 
highlight your desired nodes and hit the <<Add To Export List button to add your selected 
items to the list.   

When done, hit Save, then the Export button.  This creates an XML file containing your 
ISY’s information and displays it in your default web browser.  Save this to your PC as an 
XML file and import this saved file into your ELK.  Using ElkRP: 

Open the Automation folder 

Right-click the Lighting icon and choose “Import Lighting Data” 

 

Figure 63: Import Lighting Data 

Follow the on-screen instructions to finish importing the ISY’s information into your ELK. 

Enhanced ELK-integration capabilities are available when using the optional ELK Security 
System module.  See 3.9.5   ELK Security Module for more information. 
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3.9   Optional Modules 

Universal-Devices offers a variety of optional modules that enhance the capabilities of your 
ISY in a variety of ways.   

To purchase a module, click the HELP pull-down menu in the ISY’s Administrative Console, 
choose the “Purchase Modules” option, and follow the on-screen instructions. 

3.9.1   Network Module 

The ISY’s Network Module enhances the ISY with several key features: 

Web Server – using the Network Module, the ISY can be used as a web server to server up 
your own applications, pictures and files. 

Network Resources – with the Network Module, the ISY allows you to call any network 
resource (TCP, UDP, HTTP, HTTPS) using ISY Programs.  You can also control serial devices 
using Ethernet to RS-232 adapters. 

Wake On LAN – this feature allows you to turn on PCs and other compatible network 
devices using their Wake On LAN feature. 

Web Server 

Once installed, click on the Configuration tab in the ISY’s Administrative Console, then the 
Networking sub-tab, then the Web Server tab to copy files and folders to your ISY’s 
internal web server. 

The left side of the screen allows you to browse your local PC's files and folders.  The right 
side of the screen displays the file/folder structure within your ISY.  Simply drag-and-drop 
files and folders from the left side of the screen to your ISY’s /USER/WEB folder on the 
right-side of your screen. 

Right-click a file or folder stored on your ISY to rename, remove, or set it as your ISY Web 
Interface’s default page.  To restore the ISY Web Interface to its default home page, click the 
Use Default button on the bottom of the screen. 

Network Resources 

Once installed, click on the Configuration tab in the ISY’s Administrative Console, then the 
Networking sub-tab, then the Network Resources tab to configure your resources. 
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Once devices have been added, they will be available in ISY Programs as Actions under the 
Networking category: 

 

Figure 64: Networking Actions 

More information on known-compatible 3rd party devices and how to control them is 
available in this Wiki article: 

http://wiki.universal-devices.com/index.php?title=ISY-
99i_Series_INSTEON:Networking:Network_Resources 

Wake On LAN 

Once installed, click on the Configuration tab in the ISY’s Administrative Console, then the 
Networking sub-tab, then the Wake On LAN tab to configure. 

Once Wake On LAN devices have been added to your ISY, they will be available in ISY 
Programs as Actions under the Networking category. 

http://wiki.universal-devices.com/index.php?title=ISY-99i_Series_INSTEON:Networking:Network_Resources
http://wiki.universal-devices.com/index.php?title=ISY-99i_Series_INSTEON:Networking:Network_Resources
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3.9.2   Climate Module 

Using the Climate Module, you can create ISY Programs using local weather information as 
conditions.  This module gathers information from HAM Weather, which provides a huge 
number of weather stations to pull data from. 

To view and configure your Climate Module, click the Configuration tab in the ISY’s 
Administrative Console then the Climate sub-tab.  To choose your local weather station, 
click the FIND button and type your local City name.  Double-click your Area to see a list of 
weather stations within your area.   

   

Figure 65: Weather Stations 

Double-click a station to utilize it with your ISY.  For best results, choose a station as close 
to your location as possible. 

Once selected, choose how you would like the information displayed (English or Metric).  
Also feel free to adjust the Polling Interface, which is how often your ISY connects to 
WeatherBug for updated weather information.  Hit the Save button to save your 
configuration. 
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Figure 66: HAM Weather Configuration 

You should now see local weather information as shown below: 

 

Figure 67: Local Weather Information 



 

 -  57  - 

Now that your Climate Module has been configured, you can use this information as 
Conditions in ISY Programs.  When choosing a condition, choose Module and Climate to see 
all available conditions: 

 

Figure 68: Using Climate Conditions 

3.9.3   Electricity Module 

Brultech Electricity Meters can be utilized to monitor electricity consumption.  This 
information can be used as conditions within ISY Programs. 

To configure the ISY to pull information from your Brultech meter, click the Configuration 
tab in the ISY’s Administrative Console and choose the Electricity sub-tab.  Check the 
“Enabled” box, enter your Brultech meter’s URL, and choose the preferred polling interval 
in seconds.  Hit SAVE to save your settings to the ISY. 

 

Figure 69: Electricity Meter Settings Screen 
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Once your Brultech meter is configured, you can use this information as Conditions in ISY 
Programs.  When choosing a condition, choose Module and Electricity to see all available 
conditions: 

 

Figure 70: Electricity Conditions 

NOTE:  Check out our ISY-994iZ Series device which contains Zigbee support for 
communicating with the Brultech Electricity Meters (and more!)  

3.9.4   Open Auto Demand / Response Module 

Please peruse OpenADR Quick Setup Guide: 

 http://www.universal-devices.com/docs/production/OpenADR Quick Setup Guide.pdf  

3.9.5   ELK Security Module 

While the ISY does include some ELK integration built-in, it is fairly limited in that most of 
the integration must come from the ELK side.  For example, you can write a program on the 
ELK to turn a light on through the ISY, but you cannot write an ISY program that turns a 
light on based on the state of an ELK resource. 

The ELK Security Module changes that, fully integrating the ELK with the ISY allowing you 
to use the ELK’s available resources in your ISY programs. 

The list and state of available ELK resources can be found in the main ELK tab in the Admin 
Console.   

 

Figure 71: ELK Resources 

http://www.universal-devices.com/docs/production/OpenADR%20Quick%20Setup%20Guide.pdf
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Within this tab you can choose sub-tabs to view ELK resources such as Zones (typically 
motion sensors, door sensors, window sensors, etc.).  You can view Outputs configured on 
the ELK, and also any thermostats. 

Using your ELK resources in ISY Programs is a snap.  For example, you could trigger an ISY 
Program if a garage door sensor tied to your ELK was open: 

 

Figure 72: Using ELK Conditions 

You could also use an ISY Program to arm your ELK security system: 

 

Figure 73: ELK Actions 

3.9.6   X10 Module 

This optional module provides cleaner management and better control over A10/X10 
devices, allowing you to add them to the Admin Console’s device tree just like INSTEON 
devices. 

Please note the following limitations: 

This module uses simulated INSTEON addresses internally. Though unlikely, it could 
potentially conflict with existing INSTEON devices in your ISY, stopping you from using 
those particular INSTEON modules. 

This module only allows for ON/OFF commands in the device tree. No support for 
bright/dim. 

Note that X10 devices cannot be added to INSTEON Scenes. 

To add an A10/X10 device to your tree, click the Link Management pull-down menu and 
choose New INSTEON/A10/X10 Device. 
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Type the A10/X10 device’s address, name the device, then choose the appropriate device 
type: 

 

Figure 74: Adding an X10 Device 

Once added the A10/X10 device appears in your Admin Console’s device tree and can be 
organized or used in ISY Programs just like any other INSTEON device. 

3.9.7   The Irrigation Module 

This module is designed to calculate the amount of water that is lost from the soil and 
plants and replace it with a close approximation of what was lost. Today in a world of 
"Green is good" every consumable resource such as water can be better conserved with 
such a tool. 

The module takes the local HAM Weather data, the user settings, and calculates each day 
the average water that has been lost. The user then can have programs that respond to 

these calculations and apply the appropriate amount of water to replace that loss. When 
those programs complete they trigger a command that lets the module know that the water 

has been applied and can be subtracted from the module's tally. Each day this is done 
completing the cycle of tracking the data and applying the water. During cooler times of the 
year the watering day’s frequency slow down, and during the warmer parts of the year the 

watering frequency ramps up to daily.        
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Figure 75: Ham Weather Settings 

For more information, please see the article on our Wiki located here: 

http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-
26_INSTEON:Using_the_WeatherBug_Irrigation_Module 

 

3.9.8   Z-Wave Expansion Module 

This module provides ISY support for Z-Wave in a way that integrates with other protocols 
running on the same ISY. For example, you may add a Z-Wave lamp into a scene with 
Insteon devices.  

Supported devices  

• Thermostats  
• Lamp dimmers  
• Appliance module (on/off)  
• Schlage locks  
• Kwikset locks  
• Yale locks  

 
 

http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-26_INSTEON:Using_the_WeatherBug_Irrigation_Module
http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-26_INSTEON:Using_the_WeatherBug_Irrigation_Module


 

 -  62  - 

4   Requirements & Installation  

• ISY-994 Series with firmware version 4.1.1 or above (Help | About)  
• Z-Wave Module - 21100 (Help | About). If you do not have the Z-Wave Module, 

please do make sure you have firmware 4.1.1 installed first and then use Admin 
Console | Help | Purchase Modules ($1.00) to have it purchased/activated  

• Z-Wave Dongle, see Ordering/Assembly Instructions  
• INSTEON PLM plugged into Port A  

 

 

Figure 76: ISY as the Primary Controller and the Z-Wave network is empty 

 

At this point you may:  

• Import an existing Z-Wave network using Replication  

• Create a whole new Z-Wave network by adding devices directly from ISY  

• Make another controller the Primary by shifting it from ISY to that controller  

 

Figure 77: ISY as the Primary Controller and the Z-Wave network is not empty 

http://wiki.universal-devices.com/index.php?title=Z-Wave:_Ordering/Assembly_Instructions
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At this point you may:  

• Add more devices to the Z-Wave network directly from ISY  

• Make another controller the Primary by shifting it from ISY to that controller  

 

 

Figure 78: ISY as a Secondary Controller 

 

At this point you may put the ISY into learn mode and have the Primary controller for the 

network send the up-to-date information, and optionally shift Primary control to the ISY.  

5   Importing an Existing Z-Wave Network  

If you have the Primary Controller for your existing Z-Wave network, do the following to import 

the network into ISY.  

• From the Admin Console, Select Z-Wave -> Replicate (Learn Mode) and wait for a 

popup window to appear.  

o If the popup window does not appear, Select 'Stop Adding or Removing a Z-

Wave Device' from the advanced menu then try again.  

• Use the instructions for your Primary Controller to add a new Z-Wave device (the ISY) 

to the network, and optionally shift Primary control to the ISY.  

• Wait until the transfer is complete; the instructions for your Primary Controller should 

tell you what to look for (e.g. LEDs stop flashing, it beeps, etc.)  

o The popup window will go away, and you will see the new Z-Wave devices 

appear in the ISY device tree  
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6   Adding Devices directly from ISY  

• Make sure the ISY is the Primary Controller  

• Select Add a Z-Wave Device from the menu and wait for a popup window to appear.  

o If the popup window does not appear, Select 'Stop Adding or Removing a Z-

Wave Device' from the advanced menu then try again.  

• Put the Z-Wave device in link mode. Refer to the user guide for your product on how to 

do this. In many cases, this just requires you to press a button on the device.  

• The ISY will begin adding the device (this may occur a few seconds after you put the 

device in link mode)  

o The popup window will go away, and you will see your device added to the tree.  

Note  

• All Secure devices such as door locks must be added to the ISY directly  

 

7   Adding/Removing Devices Using Another Controller  

• Shift Primary Control to the controller you want to use for including new Z-Wave 

devices into the network  

• Add/Remove devices using the controller  

• Either Shift Primary Control back to the ISY, or update the information in ISY  

 

8   Shift Primary Control from ISY to a different Controller  

• Select Z-Wave -> Shift Primary to another Controller and wait for a popup window to 

appear.  

o If the popup window does not appear, Select 'Stop Adding or Removing a Z-

Wave Device' from the advanced menu then try again.  

• Put the other controller in Learn Mode. Refer to the user guid for your product on how to 

do this.  

• The ISY will begin making the device the new Primary Controller  

o The popup window will go away, and you will see your device added to the tree.  

 

9   Shift Primary Control to ISY  

• From the Admin Console, Select Z-Wave -> Replicate (Learn Mode)  

• Use the instructions for your Primary Controller to start Replication that shifts Primary 

Control to another device.  
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• Wait until the transfer is complete; the instructions for your Primary Controller should 

tell you what to look for (e.g. LEDs stop flashing, it beeps, etc.)  

• You should start seeing the Z-Wave devices appear in the ISY device tree  

 

10   Update the ISY with Network changes  

• From the Admin Console, Select Z-Wave -> Replicate (Learn Mode) and wait for a 

popup window to appear  

• Use the instructions for your Primary Controller to include a device into the network  

• Wait until the transfer is complete; the instructions for your Primary Controller should 

tell you what to look for (e.g. LEDs stop flashing, it beeps, etc.)  

• You should start seeing the Z-Wave devices appear in the ISY device tree  

11   Remove Devices  

• Select Remove/Exclude a Z-Wave Device from the menu and wait for a popup window 

to appear.  

o If the popup window does not appear, Select Stop Adding or Removing a Z-

Wave Device from the advanced menu then try again.  

• Put the Z-Wave device in link mode. Refer to the user guide for your product on how to 

do this. In many cases, this just requires you to press a button on the device.  

• The ISY will remove the device (this may occur a few seconds after you put the device in 

link mode)  

o The popup window will go away, but you will NOT see your device removed 

from the tree.  

Notes  

• Deleting a node from the ISY does not delete it from the Z-Wave dongle.  

• When nodes are removed with a different controller, the ISY nodes are disabled instead 

of deleted. This is done in case the user accidentally removes ISY from the Z-Wave 

network, which essentially tells ISY that all nodes are deleted. We may change this 

behavior based on Alpha feedback.  
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Figure 79: Synchronize Z-Wave Nodes 

• Select New & Deleted to synchronize only those nodes have likely changed.  

• Select All to synchronize all nodes whether they have changed or not.  

Synchronizing ensures that the ISY and the Z-Wave network have the same device information 

for a node.  

 

Figure 80: Synchronize one Z-Wave Node 
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• Select Synchronize to synchronize this node only.  

 

 

Figure 81: Antenna 

Choose the antenna the Z-Wave dongle should use (Internal or External). You must unplug ISY 

and then plug it back in for the settings to take effect.  

 

Figure 82: Factory Reset 

 

You may Factory Reset the Z-Wave dongle if it is not a member of a Z-Wave network. This 

erases all network information from the dongle, making it the Primary for an empty Z-Wave 

network.  
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Figure 83: Firmware Upgrade 

 

You must have Z-Wave Firmware version 4.55 (Z-Wave -> Advanced -> Z-Wave Version). If 

you don’t, you may upgrade the firmware in the Z-Wave dongle if it is not a member of a Z-

Wave network. This erases all network information from the dongle, making it the Primary for 

an empty Z-Wave network. You may also force it to upgrade even if you have an existing Z-

Wave network.  

Open the event viewer to see the progress of the firmware upgrade.  

• If you want to preserve your existing Z-Wave network  

o Shift primary control to a secondary controller (such as an Aeon minimote).  

o Exclude ISY from the Z-Wave network  

o Upgrade the Z-Wave firmware (Z-Wave -> Advanced -> Upgrade Z-Wave 

Firmware)  

o Include ISY back into Z-Wave network  

o Shift primary control back to the ISY  

o NOTE: Even with this procedure, you may have to exclude your door locks and 

add them back in  

• To do a fresh Z-Wave install or Overwrite your existing Z-Wave network  

o Upgrade the Z-Wave firmware (Z-Wave -> Advanced -> Upgrade Z-Wave 

Firmware)  

o Add all of your Z-Wave devices  
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11.1   Diagnostics 

The ISY includes built-in tools to help troubleshoot problems that might occur, such as 
Programs that do not behave as expected or communication issues to or from INSTEON 
devices. 

11.1.1   The Event Viewer 

The Administrative Console’s Event Viewer can be an invaluable tool in helping to diagnose 
problems.  To access the Event Viewer, click on the Tools pull-down menu, then 
Diagnostics, then Event Viewer. 

The Event Viewer window displays information on what is happening on your ISY, such as 
commands sent to devices, information received from devices, programs that are executing, 
and much more.  There are several levels of detail available using the Change Level button 
(level 3 being the most detailed).  Use the Save Log To button to save the current Event 
Viewer output to a text file. 

Refer to Appendix J: Event Viewer Log Details for details relating to the various logs 
generated by the Event Viewer. 

11.1.2   System Status 

The System Status screen shows you basic information about the ISY, such as the date and 
time it was last started, the size of the installed SD card, and how much free space is 
available. 

To access the System Status screen click on the Tools pull-down menu, then Diagnostics, 
then System Status. 

11.1.3   PLM Info/Status 

This screen tells you if the ISY is communicating with an attached PLM, and also displays 
the INSTEON address and firmware version of an attached PLM. 

To view this information click on the Tools pull-down menu, then Diagnostics, then PLM 
Info/Status. 

11.1.4   PLM Links Table 

To see the link table in your attached PLM click the Tools pull-down menu, then 
Diagnostics, then PLM Links Table.  Hitting Start begins reading the Link Table from your 
attached PLM.   
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Once complete, you can hit the Count button to see the total number of links read from 
your PLM.  This can be useful as PLMs have limits to how many links they can store.  
Unfortunately this limit does vary depending on which version PLM you have. 

There is a Stop button available on this screen which, if pressed, aborts the reading of your 
PLM’s Links Table.  Save and Load buttons are also available to export or import the Links 
Table to an XML file. 

11.1.5   Show Device Links Table 

To view the links table of an INSTEON Device, click the Tools pull-down menu, then 
Diagnostics, then Show Device Links Table.  Choose your device; adjust the starting and 
ending addresses (only if needed) and hit OK.  This will start reading the selected Device’s 
Links Table. 

Once complete, you can hit the Count button to view your Device’s total link count.  This 
can be useful as Devices do have limits to how many links they can store.  Unfortunately the 
limits do vary depending on the device. 

You can also hit the Compare button to compare the links read in from the Device to the 
list of links the ISY believes the Device should have.  If there is a discrepancy, you may want 
to run a Restore on the device to correct the links table.  For more information on the 
Restore function, see 3.2.6   Other Functions (Restore, Disable, Query, etc.). 

There is a Stop button available on this screen which, if pressed, aborts the reading of your 
Device’s Links Table.  Save and Load buttons are also available to export or import the 
Links Table to an XML file. 

11.1.6   Show ISY Links Table 

To view the list of links that the ISY believes a device should have, click the Tools pull-
down menu, then Diagnostics, then Show Device Links Table.  Choose your device and 
hit OK and the links table displays. 

You can hit the Count button to view your Device’s total link count.  This can be useful as 
Devices do have limits to how many links they can store.  The limits vary depending on the 
device. 

There are also Save and Load buttons available to export or import the links table to an 
XML file. 
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11.1.7   Scene Test 

The Scene test function can be very helpful in troubleshooting INSTEON communication 
issues.  To open this tool, click the Tools pull-down menu, then Diagnostics, then Scene 
Test.  Choose the Scene you would like to test then hit OK. 

The Event Viewer pops up and an ON and OFF command are sent to the specified scene.  
The results of the test will be displayed in the Event Viewer window, indicating whether 
the test succeeded or failed for each member of the scene. 

11.1.8   Query INSTEON Engine 

If a device is not behaving as expected (for example, On Level or Ramp Rate is not working 
properly) the ISY may not have proper information about the device’s capabilities.  To 
refresh this information simply right-click the Device in the node list and choose Query 
INSTEON Engine.  This will update the ISY’s stored information and may correct the issue 
you are having.   

12   Glossary 

Action:  Commands that are run when an IF statement is true (a THEN Action) or when an 
IF statement is no longer true (an ELSE Action).  Examples are On, Off, Fast On, 
Query, etc. 

Controller:  A device that not only responds to commands issued to a scene, it also controls 
the scene.  An example of a Controller might be a button located on a Keypad – 
when that Keypad button is pressed, all members of the scene respond as 
programmed.  Controllers are colored red within a scene. 

Cross-Linking:  A configuration where two items control the same device.  For example, 
you might have two switches in your kitchen that you’d like to control your 
kitchen table light.  One switch is physically attached to the kitchen table light, 
but you’d like the other switch to control it as well.  In this case you would add 
each device to a Scene as a Controller (shown in red).   

Device Group:  An INSTEON device that creates multiple entries within the ISY.  For 
example, a KeypadLinc can have 6 or 8 nodes in the ISY (one for each button).  
You can choose to group these nodes together in a scene by right-clicking the 
primary node and choosing “Group Devices.” 

INSTEON:  An integrated network protocol that combines wireless radio frequency (RF) 
with the home's existing electrical wiring.   This dual-mesh network approach 
means INSTEON is faster and more reliable than X10.  INSTEON is a peer-to-peer 
network.  Its devices do not require network supervision and for 
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straightforward applications an INSTEON network can operate effectively 
without a central controller. 

Each INSTEON device has a unique factory-assigned address.  Like X10, each 
INSTEON device constantly listens for any command broadcast by other 
INSTEON devices, but unlike X10, each INSTEON device broadcasts each 
command it generates and can re-broadcast each command it receives.  

When an INSTEON device is broadcasting a command it is acting as a Controller; 
when responding to a command received from an INSTEON device it is acting as 
a Responder. 

Each INSTEON device can be “taught” to respond to commands issued by any 
INSTEON device in that network.  INSTEON devices can be taught to respond 
collectively and thereby create Scenes.  In a Scene, one from a number of 
INSTEON devices can broadcast a signal that causes one or several INSTEON 
devices (possibly including itself) to turn on or off or to change state in some 
more subtle way. 

INSTEON scenes offer practical solutions to many domestic lighting problems: 
tap one key and so set each of the lights in the family room to that state for 
which the home theatre is most effective, tap another to ensure all basement 
lights are switched off once at the top of the stairs, or a third to ensure the 
staircase and upstairs landing lights are both on before a guest is dispatched to 
find the upstairs bathroom.  

INSTEON scenes are easy to set up initially but as more scenes are added 
changing and maintaining them can become burdensome.  While leaving existing 
scenes unchanged, ISY can discover them and bring them under the control of 
the ISY.  There they can be easily managed, enhanced and coordinated with 
other scenes and X10 devices. 

Infrared (IR):  Relating to the invisible part of the electromagnetic spectrum with 
wavelengths longer than those of visible red light but shorter than those of 
microwaves. 

Notification:  Using Programs, you can configure the ISY to send you notifications via text 
message or email.  For example, the ISY could notify you if your thermostat 
drops below or above a pre-defined temperature. 

On Level:  The brightness level at which a device is turned on when pressed (25%, 75%, 
etc.).   
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PowerLinc Modem (PLM):  A family of products sold by Smarthome.  It consists of the 
2412S (now discontinued) and the 2413S which are sold separately.  The PLM is 
required to interface with INSTEON devices. 

Program:  the true power of the ISY allowing you to extend the capabilities of INSTEON 
and other devices using timers, triggers, macros, etc.  Programs also allow you to 
utilize the ISY’s optional IR receiver, optional modules, and more.  ISY Programs 
are created using simple buttons and pull-down menus.  Programs require that 
the ISY is online in order to function. 

Ramp Rate:  The speed at which a device is turned on when activated.  For example, a slow 
Ramp Rate causes a light to turn on slowly when a button is pressed. 

Responder:  A device contained within scenes that only responds to commands issued to 
the scene.  For example, a lamp module with a table lamp attached would likely 
be a Responder to the scene.  When the scene is turned on, the lamp module 
might turn on.  When the scene is turned off, the lamp module might turn off.  
Responders are colored blue within a scene. 

Scene:  A collection of INSTEON devices that react to and with one another in various ways.  
Scenes are comprised of both Responders and Controllers.  Scenes may be 
initiated by an INSTEON event or by a Program. 

Theme:  Several pre-defined ISY Administrative Console color schemes to available from 
the File menu. The Administrative Console must be closed and re-opened for the 
Theme change to take effect. 

Universal Plug and Play (UPnP):  A set of standards intended primarily for residential 
networks to enable users to link their local and remote personal computers, 
printers, Internet gateways, Wi-Fi access points and mobile devices to 
seamlessly discover each other's presence on the network and establish 
functional network services for data sharing, communications, and 
entertainment. 

Variable:   Program parameters that can be stored, modified using arithmetic operations, 
and compared.  You can use Variables to provide information, trigger programs, 
etc.  There are two different types of Variables: Integer and State.  A State 
Variable creates an event when it is modified, so it can be used to trigger ISY 
Programs when it is currently or reaches a certain value.  An Integer Variable is 
not used to trigger a Program. 

X10:  A protocol for communication among electronic devices used for home automation.  
Developed in 1975, X10 was the first general purpose network technology to 
allow remote control of home devices and appliances for residences.  With new 

https://en.wikipedia.org/wiki/Wi-Fi
https://en.wikipedia.org/wiki/Network_service
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components still available and millions of units in use worldwide, it remains 
today’s most widely deployed home automation protocol. 

X10 primarily uses power line wiring for signaling and control.   Each X10 switch 
has a user-assigned address.  The way X10 addresses are applied to switches 
depends on type and manufacturer.  X10 switches operate by responding to the 
physical control (switch) on the device itself or by responding to a X10 control 
signal addressed to that switch from an X10 signal source elsewhere in the 
residence’s electrical system.   

Typically, X10 devices are either controllers that generate X10 signals or light 
switches or electrical sockets that respond to X10 signals.  Controllers that are 
only capable of generating X10 signals tend to have a somewhat utilitarian 
appearance, so X10 signals are now often generated by Dual-Band devices such 
as the KeypadLink controller, by a PDA via an IR/X10 protocol converter, or 
better yet, by a program in the ISY. 

Although, as a protocol, X10 lacks the capabilities and operational reliability of 
INSTEON, X10 switches remain the preferred way to control devices that may 
create surges at power on such as traditional fluorescent lights and general 
purpose electrical sockets. 
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Appendix A: Front and Rear Panel LEDs 

Front Panel LEDs:  Understanding the ISY’s front panel (see below) LEDs can be helpful 
when troubleshooting problems.   

 

Figure83: ISY Front Panel 

Here is a table that helps explain each LED and LED combinations: 

LED or Combination Indicated Status 
Power on steady The PWR LED indicates that the ISY has power, either through the 

PLM or via a separate AC adapter.  If the PWR LED is not lit, the ISY 
does not have power. 

RX, TX and Memory off If all three of these LEDs are off, the ISY is idle. 

RX blinking The RX LED blinks when the ISY is receiving INSTEON traffic.  

TX blinking The TX LED blinks when the ISY is sending INSTEON traffic. 

Memory blinking The MEM LED blinks when the ISY is accessing its internal memory. 

RX on steady If the RX LED is on steady, the ISY is having a problem 
communicating with the PLM.  Unplug the PLM for 10 seconds, 
then plug it back in to reboot.  If the problem continues, either the 
PLM or cable is most likely defective. 

Error blinking A blinking ERR LED indicates a file system error.  Please power off 
the ISY and try to re-seat the SD card.  If that does not help, the SD 
card may be defective.  Please see Appendix C: Upgrading Your SD 

Card 
Memory and Error 
blinking 

If both the MEM and ERR LEDs are blinking, the ISY is unable to 
communicate with your Ethernet network.  Please check all cable 
connections, try rebooting your router or switch, and ensure that 
you have a DHCP server available. 
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Rear Panel LEDs:  There are also 2 LEDs on the rear of the ISY where the Ethernet cable 
attaches.  One LED indicates a good network connection (should be on solid) while the 
other should flash with network activity. 
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Appendix B: Factory Reset 

There are only a few reasons why you might want to factory reset your ISY.  In most cases, 
a factory reset will not help any problems you might be having. 

Please be sure to thoroughly investigate your problem before trying a factory reset.  If 
possible, be sure to have a known good backup of your ISY’s configuration before factory 
resetting. 

NOTE:  A factory reset of the ISY will not erase any programming stored on INSTEON 
devices. 

To factory reset your ISY: 

• Use a sharp object (for example an straightened paperclip) to push in the recessed 
Reset button and watch for the RX, TX, MEM, and ERR LEDs to start flashing (once per 
second). 

• Hold the Reset button for approximately 30 seconds more, until the above LEDs turn off 
and the MEM LED flashes quickly. 

Release the Reset button and wait for the ISY to reboot (when the MEM LED stops flashing). 
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Appendix C: Upgrading Your SD Card 

In some instances you may want to replace your SD card.  For example: 

• You are experiencing a blinking ERR light which could indicated a bad SD card. 

The ISY supports up to a 16GB SD card. 

Once your SD card is replaced, you will need to re-load the firmware onto your ISY as well 
as restore your configuration from a backup.  Please be sure to have a good backup before 
attempting an SD card upgrade. 

With you ISY you have an externally accessible SD card.  Simply unplug all cables from 
your ISY, pull out the old SD card, and insert the new SD card.  You will also need to reload 
the firmware onto your ISY.  Proceed to the paragraph labeled “Reloading The ISY 
Firmware and Restoring From Backup.” 

 

 

 

Figure 84: ISY with Cover Removed 
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Once you screw the ISY back together, you will need to reload the firmware.  Proceed to 
the paragraph labeled “Reloading The ISY Firmware and Restoring From Backup”. 

Reloading the ISY Firmware and Restoring From Backup 

Once you’ve replaced your ISY’s SD card, you will need to re-load the firmware as well as 
restore your configuration from a backup. 

• Boot your ISY with the new SD card installed 

From a PC on your LAN, visit the following URL to launch the Administrative Console and 
locate your ISY (This link may not work with Chrome):  
http://isy.universal...com/994i/4.2.30 

• Login to the Administrative Console (default username and password are both “admin”) 

• Click on the HELP pull-down menu, then MANUALLY UPGRADE MY LIGHTING. 

• Browse to the firmware file you wish to install.  If you do not have a copy of the ISY 
firmware, please visit our forum for the download link:   

http://forum.universal-devices.com/viewforum.php?f=25 

• After the firmware is installed your ISY reboots.  Please re-launch the Administrative 
Console and login:  http://www.universal-devices.com/994i 

• Click on the FILE pull-down menu, then RESTORE ISY and choose your last backup. 

http://isy.universal...com/994i/4.2.30
http://isy.universal...com/994i/4.2.30
http://forum.universal-devices.com/viewforum.php?f=25
http://www.universal-devices.com/994i
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Appendix D: Troubleshooting INSTEON Communication Issues- 

It is important to have a pair of INSTEON AccessPoints or other INSTEON RF devices (or an 
INSTEON-compatible hardwired coupler) installed to ensure good communications 
between both legs of power in your home.  See Smarthome’s documentation for ensuring 
your AccessPoints are installed on opposite legs of power.  We recommend placing them as 
close to your electrical panel as possible. 

An AccessPoint (or other INSTEON RF receiver, such as their 2413S Dual-Band PLM) is also 
required to communicate with INSTEON RF devices. 

Most INSTEON devices use powerline technology to communicate with one another.  Some 
devices on in your home may interfere with device communications.  Some known 
offenders are: 

• Low voltage lighting 
• Fluorescent lighting 
• CFLs 
• Desktop computers and notebooks 
• Surge protectors 
• UPSs 

In many cases these devices can exist on your powerline with no problem.  But, if you are 
experiencing communication issues, we highly recommend unplugging any devices you 
have on the above list.  Once you establish reliable communications, add the devices back in 
one at a time to find the cause.  Most troublesome plug-in devices can be filtered using 
FilterLincs from Smarthome. 

Because the ISY sends and receives all INSTEON signals through the PLM, we highly 
recommend plugging it in to an outlet away from potentially noisy electrical devices, such 
as PCs and UPSs, and as close to your electrical panel as possible.  DO NOT plug your PLM 
into a surge protector or UPS.  We also highly recommend installing an AccessPoint as close 
to your PLM as possible. 
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Appendix E: Assigning a Static IP Address to the ISY 

If you wish to assign a static IP address to your ISY, please open the Configuration tab, then 
the System sub-tab.  Uncheck the “Automatic (DHCP)” box and fill out the fields in the 
Network Settings section: 

 

Figure 85: Assigning a Static IP Address 

To avoid IP address conflicts, be sure to choose an address outside of the DHCP range set 
on your router.  Also be sure to type the correct Gateway and DNS addresses (typically 
your router IP address), otherwise the ISY will not have access to the internet. 

You can also configure custom HTTP and HTTPS ports on this screen. 

If you check the Automatic (DHCP) option, the ISY will not use a static IP address but 
instead get an IP address automatically from a DHCP server on your network. 
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Appendix F: User Enhancement Details 

The ISY firmware releases contain enhancements often resulting from user requests.  Some 
of these enhancements are at a level of detail not included in this User Guide however they 
are important to some users.  Following is the list of these enhancements for Official 
Release 4.2.30.  Please refer to the following website for additional Official Release 4.2.30 
information:  http://forum.universal-devices.com/topic/15795-release-4230-is-now-
official/ 

[994iZS] - Support for smaller install keys 

[Irrig] Added PlantType as well as local information 

[Irrig] More accurate calculations for ET 

[994iZ] Value ranges from 0 and more granular 

[994iZS] Show error icon in case ISY has trouble communicating with the meter  

[52] Increased support from 1024 to 2048 programs on the PRO series 

- Group cleanup numbers are now configurable between devices and devices and the PLM 

[New] Network Module - create/update/delete files and directories in the local ISY web 
directory (/user/web) using Custom Notifications in Programs 

- More debugging for Z-Wave 

- Support for Z-Wave Alpha 

- Support for KeypadLinc Dimmer 6 buttons 2334-2 

- Support for KeypadLinc Dimmer 8 buttons 2334-2 

 [04] Added (100%) to On Statement  

- ISY Finder enhancements 

[33] Sorting alphabetical order  

- Save and load list (after each cache clearing, the list is cleared) 

[21] Add Program ID in the UI  

http://forum.universal-devices.com/topic/15795-release-4230-is-now-official/
http://forum.universal-devices.com/topic/15795-release-4230-is-now-official/
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- Program ID column in Program Summary 

- Program Summary table layout is now saved between sessions 

- OpenADR 1.0 events in the dashboard 

- Minimal support for IP Cameras in the default interface 
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Appendix G: Manually Upgrading Your Firmware 

To manually download and install a firmware release, please see the following forum 
where both final and beta releases are regularly posted along with specific upgrade 
instructions:  http://forum.universal-devices.com/forum/15-current-release-betas-
and-bug-reports/ 

In general, please note the following before performing a firmware update: 

• The downloaded firmware MUST remain zipped.  DO NOT unzip the downloaded file. 

• Please ensure you have a good backup before attempting a firmware update. 

• Disable all anti-virus and firewall software before attempting a firmware update. 

• Be sure to run firmware updates from a stable and, if possible, hardwired network 
connection.  Avoid running firmware upgrades from marginal wifi connections or off-
site locations if possible. 

• Once downloaded, click the HELP pull-down menu, then MANUALLY UPGRADE MY 
LIGHTING, and browse to the firmware file you have downloaded. 

• After upgrading your firmware, please close all browser windows and clear your Java 
cache as outlined in this article:   

http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-
26_INSTEON:Clearing_Your_Java_Cache  

 

http://forum.universal-devices.com/forum/15-current-release-betas-and-bug-reports/
http://forum.universal-devices.com/forum/15-current-release-betas-and-bug-reports/
http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-26_INSTEON:Clearing_Your_Java_Cache
http://wiki.universal-devices.com/index.php?title=ISY-99i/ISY-26_INSTEON:Clearing_Your_Java_Cache
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Appendix H: INSTEON Device Notes 

Some INSTEON devices require special care when used with the ISY.  Some need to be 
added to the system in a specific way, and some have unique options available when 
configuring with the ISY.  This section details some of this information and more.   

As always, please refer to the manufacturer’s documentation first.  Please consider the 
following notes as a secondary source of information. 

The following notes are sorted alphabetically by device name. 

ApplianceLinc 

Current ApplianceLincs will not act as Controllers – they will not notify the ISY or control 
other linked devices if turned on or off locally (via the SET button or using load sensing).   

EZI/O Devices (SimpleHomeNet) 

Due to variations in firmware on SimpleHomeNet devices, some units (especially older 
firmware) may not work well with the ISY.  Symptoms include the ISY not being notified of 
sensor state changes. 

If you’re having an issue with the ISY receiving status updates from an EZIO device, try the 
following steps: 

• remove the device from the ISY 
• factory reset the device 
• add the device back to the ISY by using “New INSTEON Device” and typing in the 

address 

I/OLinc 

Several options are available when configuring an I/OLinc on the ISY.  These include: 

• Timeout (seconds) - Sets the length of time the relay will close when Momentary is 
selected. 

• Program Lock - Disables Set Button programming. 
• Relay Follows Input - Sets Relay On when Sensor is On and Off when sensor if Off. 
• Send X10 Send On (or Off) - Send X10 when the sensor changes. 
• Trigger Off - If the TrigOff bit is set, Close Switch sends an OFF and Open Switch sends 

an ON. If the TrigOff bit is clear, Close Switch sends an ON and Open Switch sends an 
OFF.  

• LED on TX - The LED flashes when the device sends INSTEON commands.  
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• Momentary: A - The relay will close momentary. If it is Linked while On it will respond 
to On. If it is Linked while Off it will respond to Off.  

• Momentary: Look at Sensor - If the sensor is On the relay will close momentarily when 
an On command is received. If the sensor is Off the relay will close momentarily when 
an Off command is received.  

• Momentary: Both - On and Off both cause the relay to close momentary.  

KeypadLinc 

KeypadLincs show up as multiple nodes on the ISY (6 button or 8 button, depending on 
which model KeypadLinc).  When switching between 6 and 8 button modes on the 
KeypadLinc, the device must be removed and re-added to the ISY. 

Only the KeypadLinc’s primary load button can be controlled directly by the ISY (through 
the Admin Console and ISY Programs).  To control secondary buttons, create a Scene 
containing the button and control the scene. 

KeypadLincs support several unique options, such as: 

• Manually Exclusive Buttons – groupings of buttons so that one and only one button in 
the group can be ON at any one time. 

• Toggle Mode – toggle a button to always stay ON or OFF (and only send the respective 
command when pressed) 

• LED Brightness – adjust the KeypadLinc button LED brightness 

Due to variations in KeypadLinc firmware, some configuration options may or may not be 
available. 

LampLinc 

Most LampLincs will not act as Controllers – they will not notify the ISY or control other 
linked devices if turned on or off locally (via the SET button or using load sensing).  
LampLincs labeled v4.2 or higher (firmware v33+) should act as Controllers. 

Motion Sensor 

Motion Sensors are RF devices, thus require the installation of an INSTEON RF receiver 
(such as an INSTEON AccessPoint).   

The Motion Sensor cannot be linked using Auto Discover.  To link a Motion Sensor to the 
ISY, please choose the LINK MANAGEMENT pulldown, then NEW INSTEON DEVICE.  Enter 
the device address manually (found inside the battery compartment), then select the 
“2420M INSTEON Motion Sensor” from the Device Type list. 
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Since the Motion Sensor is a battery-saving RF device, you must put the device into linking 
mode to add it to the ISY (and make any changes to the device, such as adding/removing 
from scenes).  Please follow the on-screen instructions to put the Motion Sensor into 
linking mode when prompted (hold SET button for 5 seconds). 

Once added to the ISY, the Motion Sensor will show up as 3 nodes.  The primary node is the 
motion sensing portion of the device, which updates according to sensed motion (or lack of 
motion).   

There is also a DUSK/DAWN node that will show ON when the device senses darkness and 
show OFF when the device senses light.  The Motion Sensor will not update this node until 
approximately 3.5 minutes after a state change has persisted. 

Finally, a Low Battery node will show as ON when the Motion Sensor senses a low battery 
condition and notifies the ISY. 

Motion Sensors support several unique options, such as: 

• Timeout (minutes) - Defines the period of inactivity before the Motion Sensor sends an 
Off. Default = 1 minute. Range = 0.5 - 8.5 minutes in 30 second increments.  

• LED Brightness - Default = 100. Range is 0 - 255.  
• Darkness Sensitivity - The higher the value, the darker it needs to be for the unit to see 

night. Default = 35. Range = 0 - 255. 

RemoteLinc 

RemoteLincs are RF devices, thus require the installation of an INSTEON RF receiver (such 
as an INSTEON AccessPoint).   

RemoteLincs link differently than other INSTEON devices, this require a separate linking 
routine.  To link a RemoteLinc to your ISY, click the LINK MANAGEMENT pulldown and 
choose LINK A REMOTELINC and follow the on-screen instructions.  Since the RemoteLinc 
is a battery-saving RF device, it must be put into linking mode whenever adding to the ISY 
or making changes (such as adding or removing from a scene).  To put the device in linking 
mode, hold Button 1 down for 10 seconds, or until the light starts flashing. 

To EXIT linking mode, either wait for the RemoteLinc to time out and the LED to stop 
flashing (4 minutes), or simply hit the BRIGHT or DIM button.  DO NOT hit one of the 6 
rocker buttons. 

RemoteLincs show up as a multiple nodes on the ISY (one node per button). 
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Thermostat & Wireless Thermostat (2441TH / 2441ZTH) 

There is a Program Action available to synchronize the Thermostat time with that of the 
ISY. 

Thermostat Adapter 

Older INSTEON Thermostat Adapters cannot act as Controllers, thus they do not notify the 
ISY of any state changes.  To get the most current information from your thermostat, we 
recommend using an ISY Program to poll the device periodically.  See Appendix I: Sample 
ISY Programs. 

Newer Thermostat Adapters (V2) do notify the ISY of state changes, so a poll Program will 
not be necessary. 

TriggerLinc 

TriggerLincs are RF devices, thus require the installation of an INSTEON RF receiver (such 
as an INSTEON AccessPoint).   

The TriggerLinc cannot be linked using Auto Discover.  To link a TriggerLinc to the ISY, 
please choose the LINK MANAGEMENT pulldown, then NEW INSTEON DEVICE.  Enter the 
device address manually (found inside the battery compartment), then select the “2421 
TriggerLinc” from the Device Type list. 

Since the TriggerLinc is a battery-saving RF device, you must put the device into linking 
mode to add it to the ISY (and make any changes to the device, such as adding/removing 
from scenes).  Please follow the on-screen instructions to put the TriggerLinc into linking 
mode when prompted (hold SET button for 5 seconds). 

Once added to the ISY, the TriggerLinc will show up as 2 nodes.  The secondary node is only 
used when the TriggerLinc is in “Multi-Scene” mode.   

When in Normal mode, the TriggerLinc sends an ON command to the primary node when 
the sensor is open (magnet pulled away) and an OFF command when the sensor is closed 
(magnet close to sensor).   

When in Multi-Scene mode, the TriggerLinc sends an ON command to the first node when 
the sensor is open, and an ON command to the second node when the sensor is closed.  It 
will NOT send an OFF command to either node when in Multi-Scene mode.  
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Appendix I: Sample ISY Programs 

This section contains some sample ISY Programs to get you started. 

Periodically poll your Thermostat Adapter: 

If 
        From    12:00:00AM 
        For      24 hours  
  
Then 
        Repeat Every  15 minutes  
           Wait  10 minutes  
           Set 'Thermostat' Query 
  
Else 
   - No Actions - (To add one, press 'Action') 

  

Front door light ON 20 minutes after sunset, OFF at 10pm: 

If 
        From    Sunset  + 20 minutes 
        To      10:00:00PM (same day) 
  
Then 
        Set Scene 'FrontDoor' On 
  
Else 
        Set Scene 'FrontDoor' Off 
  

Turn off closet light after 10 minutes: 

If 
        Status  'Closet' is not Off 
  
Then 
        Wait  10 minutes  
        Set 'Closet' Off 
  
Else 
   - No Actions - (To add one, press 'Action') 
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Notify you of extreme temperature conditions: 

If 
        Status  'Thermostat' > 90° (Temperature) 
     Or Status  'Thermostat' < 60° (Temperature) 
  
Then 
        Send Notification to All 
  
Else 
   - No Actions - (To add one, press 'Action') 

Turn driveway lights ON and OFF with an X10 remote: 

If 
        X10 'A2/On (3)' is Received 
    And X10 'A2/Off (11)' is not Received 
  
Then 
        Set Scene 'Driveway' On 
  
Else 
        Set Scene 'Driveway' Off 

Increase a counter called “LightCounter” whenever a particular light is switched on: 

If 
         Control 'Basement Light' is switched On 

Then 
           $LightCounter += 1 

  Else 
   - No Actions - (To add one, press 'Action') 

Send a notification email whenever the variable “LightCounter” reaches a value of 5, 
then reset it back to 0: 

If 
        $LightCounter is 5 

  Then 
  Send Notification to 'My Email' 
  $LightCounter  = 0 

Else 
         - No Actions - (To add one, press 'Action') 
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Appendix J: Event Viewer Log Details 

Viewing the Log File: 

From the ISY Administrative Console select the Tools/Log menu item.  A window opens 
asking if you wish to view the Log in Excel.  Selecting Yes produces a file and opens Excel. 
Selecting No opens a window allowing you to save the file to a location of your choice. Start 
your database program and open the saved log file.  Sorting can be applied as your 
database program allows. 

When opening the log in Excel you will be requested to allow macros to run. You must 
select OK for the macro to run and to have access to the log file.   

The log file contains the date and category intersections for all the devices linked to ISY.  
The columns provided are INSTEON Device, Control, Value, Time, User, and Log Type.  
Below is a sample Log file viewed in Excel. 

 

Figure 84: Sample Log File 

The log can be cleared using the menu item Tools/Clear Log. 

Error Messages 

The System, Web Services/SOAP, SMTP, and Driver error codes (see the tables below) are 
contained in the Log Type column. 

INSTEON Control Value Time User Log Type

0 null  Fri 2013/04/05 14:58:09 System Start

Scene:ISY Status Query Fri 2013/04/05 14:58:11 System Log

X10 F Bright (7) Fri 2013/04/05 18:09:50 System Log

X10 F Bright (7) Fri 2013/04/05 18:09:51 System Log

X10 F Bright (7) Fri 2013/04/05 18:09:51 System Log

X10 F Bright (7) Fri 2013/04/05 18:09:51 System Log

X10 F Bright (7) Fri 2013/04/05 18:09:52 System Log

X10 F Bright (7) Fri 2013/04/05 18:09:52 System Log

X10 F5  Fri 2013/04/05 18:19:38 System Log

X10 F5 Off (11) Fri 2013/04/05 18:19:39 System Log
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System Errors 

System Errors 
Number Error Message 

-1 REQUEST_FAILED_ERROR  

-2 DEVICE COMMUNICATION ERROR timed out waiting for the device to 
respond or got a NACK 

-3 DEVICE RETURNED INVALID NODE an address that we don't have in 
our nodemap 

-4 DEVICE RETURNED INVALID ADDRESS communication error 

-10 UNEXPECTED DEVICE RESPONSE  

-20 MAIN LOCAL DEVICE BLANK  

-500 HAML DRIVER LISTENER NOT REGISTERED the listener has not been 
registered 

-1000 HAML PARSER UNDEFINED ELEMENT  

-1001 HAML PARSER ONDATA  

-5001 UPNP DRIVER NO DEVICES CONFIGURED  

-5002 UPNP DRIVER SERIAL READER FAILED  

-5003 UPNP DRIVER MAX DEVICES  

-5004 UPNP SERVICE TYPE SEARCH NS we don't support service type 
search requests yet 

-5005 UPNP SUBSCRIPTION NOT FOUND FOR RENEWAL  

-5006 UPNP SUBSCRIPTION NOT FOUND FOR CANCELATION  

-5007 UPNP INVALID SUBSCRIPTION URL  

-5008 UPNP INVALID SUBSCRIPTION CALLBACK  

-5009 UPNP MAX SUBSCRIBERS  

-5010 UPNP SUBSCRIBER TCP CONNECT FAILURE tried to connect to the subscriber's 
ip/port but timed out 

-5011 PROCESS DEVICE STATE CHANGE SID NOT FOUND  

-5012 UPNP SUBSCRIBER NOREPLY TO EVENT 1 subscriber didn't reply to the 
event:couldn't write header 

-5013 UPNP SUBSCRIBER NOREPLY TO EVENT 2 subscriber didn't reply to the 
event:couldn't write body 

-5014 UPNP SUBSCRIBER NOREPLY TO EVENT 3 subscriber didn't reply to the 
event:read time out 

-5015 UPNP CONTROL MALFORMED SOAP REQUEST 1 missing body; we got a malformed 
control request 

-5016 UPNP CONTROL MALFORMED SOAP REQUEST 2 chopped off URL 

-5017 UPNP_CONTROL_MALFORMED_SOAP_REQUEST_3 missing node 

-6000 OS DUPLICATE TASK PRIORITY  

-6001 OS OPEN SERIAL FAILED  

-7000 D2D SUBSCRIBE TCP CONNECT FAILURE could not connect to the xternal 
device to subscribe to its events 

-7001 D2D MAX REMOTE LISTENER THREADS  
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System Errors 
Number Error Message 

-7002 D2D FACTORY FILE NOT FOUND tried to use a static d2d file but it 
doesn't exist 

-7003 D2D MALFORMED RULE MISSING SENSE TAG the <Sense> tag is missing 

-7004 D2D MALFORMED RULE MISSING SENSE ID ATTR missing the id attribute in the 
sense tag 

-7005 D2D MALFORMED RULE UNDEFINED TAG missing the condition tag 

-7008 D2D MALFORMED RULE MISSING RESPOND TAG missing the <Respond> tag 

-7009 D2D EVENT MISSING SOAP BODY missing soap body for the received 
event 

-7010 D2D UNKNOWN CONDITION OPERATION operations could be either of 
=<or> 

-7011 D2D EVENT MISSING PROPERTY TAG missing <e:property tag in the 
received event 

-7012 D2D SUBSCRIPTION REMOTE DEVICE NOT FOUND tried to subscribe to the remote 
device but couldn't find it 

-7013 D2D SUBSCRIPTION FAILED NO REPLY although made a connection but 
the device didn't reply back 

-7014 D2D SUBSCRIPTION FAILED NO SID RETURNED subscribed to the external device 
but it didn't return an sid 

-7015 D2D DESCRIPTION MALFORMED URL the url to the device is malformed 

-7016 D2D UNSUBSCRIPTION FAILED NO REPLY tried unsubscribing but no reply 
from the device 

-7017 D2D REQUEST FAILED NO ACTION a request was sent but it didn't 
have an action 

-7018 D2D CONDITION CHECK FAILED NO ACTION  

-7019 D2D PARSER ERROR SENSE NOT FOUND  

-7020 D2D PARSER ERROR  

-7021 D2D FACTORY SUBSCRIBE URL FAILURE couldn't open a socket connection 
to the d2d factory url 

-7022 D2D FACTORY SUBSCRIBE NO REPLY although subscribed to the factory 
default no reply was returned 

-7023 D2D COMPRESSION FAILED tried to compress the d2d rules 
but failed 

-7024 D2D DECOMPRESS FAILED tried to decompress the d2d rules 
but failed 

-7025 D2D RETRIEVE INITIALIZE FAILED after decompressing tried 
initializing the d2d but failed 

-7026 NOTIFICATIONS DNS ERROR  

-7027 NOTIFICATIONS MAIL SERVER NOT SETUP  

-7029 NOTIFICATIONS MAIL TO ADDRESS REQUIRED  

-7030 NOTIFICATIONS SEND MAIL FAILED  

-7050 D2D EXPECTED D2D TAG Expected D2D tag but got 
something different 
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System Errors 
Number Error Message 

-7051 D2D UNEXPECTED TAG IN SENSE Found an unexpected tag in the 
XML stream 

-7052 D2D UNEXPECTED TAG IN CONDITION Found an unexpected tag in the 
XML stream 

-7053 D2D UNEXPECTED TAG IN RESPOND Found an unexpected tag in the 
XML stream 

-7501 DIAG PARSER ERROR Error in UPBDiagParser 

-7601 LINK PARSER ERROR Error in UPBLinkDevices 

-9000 SYSTEM NOT INITIALIZED POST FAILED system is not intialized yet while 
trying to post 

-9001 SYSTEM NOT INITIALIZED PUBSUB FAILED  

-10001 RANDOM GEN START ERROR  

-10002 RANDOM GEN READY ERROR  

-10003 RANDOM GEN ADD ENTROPY ERROR  

-10004 CTR START ERROR  

-10005 CTR ENCRYPT ERROR  

-10006 CTR SET IV ERROR  

-10007 CTR DECRYPT ERROR  

-10008 RSA KEY GENERATION FAILED  

-10009 RSA PUBLIC KEY IMPORT FAILED  

-10010 RSA PRIVATE KEY IMPORT FAILED  

-10011 RSA REIMPORT KEYS FAILED  

-10012 RSA EXPORT PUBLIC KEY FAILED  

-10013 RSA EXPORT PRIVATE KEY FAILED  

-10014 RSA MODULUS CONVERSION TO CHAR FAILED  

-10015 RSA EXPONENT CONVERSION TO CHAR FAILED  

-10016 RSA MODULUS ENCODING TO BASE 64 FAILED  

-10017 RSA EXPONENT ENCODING TO BASE 64 FAILED  

-10018 LIFETIME SEQUENCE ENCODING TO BASE 64 FAILED  

-10019 SET SESSION BASE64 DECODE FAILED  

-10020 SET SESSION RSA DECRYPT FAILED  

-10021 SET SESSION KEY PARSER FAILED  

-10022 SET SESSION KEY UNSUPPORTED BULK ALGORITHM  

-10023 BULK KEY INITIALIZATION FAILED WRONG KEY LENGTH the vector sent to initialize a bulk 
key is too long 

-10024 BULK KEY INITIALIZATION FAILED WRONG IV LENGTH  

-10025 BULK KEY INITIALIZATION FAILED WRONG KEY IV LENGTH  

-10028 SET SESSION INVALID BULK KEY  

-10029 SET SESSION AES INIT FAILED  

-10030 SET SESSION AES DECRYPT FAILED  

-10031 SET SESSION CIPHER TEXT BASE64 DECODE FAILED  

-10032 SET SESSION CIPHER TEXT PARSER FAILED  

-10033 SET SESSION KEY UNSUPPORTED BULK ENC ALGORITHM  
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System Errors 
Number Error Message 

-10034 SET SESSION KEY UNSUPPORTED SIGN ALGORITHM  

-10035 SET SESSION CIPHER TEXT ENC KEY TO DEVICE BASE64 
DECODE FAILED 

 

-10036 SET SESSION CIPHER TEXT ENC KEY FROM DEVICE BASE64 
DECODE FAILED 

 

-10037 SET SESSION CIPHER TEXT SIGN KEY TO DEVICE BASE64 
DECODE FAILED 

 

-10038 SET SESSION CIPHER TEXT SIGN KEY FROM DEVICE BASE64 
DECODE FAILED 

 

-10039 SET SESSION ENCRYPT KEY TO DEVICE ASSIGNMENT 
FAILED 

 

-10040 SET SESSION ENCRYPT KEY FROM DEVICE ASSIGNMENT 
FAILED 

 

-10041 SET SESSION SIGN KEY TO DEVICE ASSIGNMENT FAILED  

-10042 SET SESSION SIGN KEY FROM DEVICE ASSIGNMENT FAILED  

-10043 SET SESSION CIPHER TEXT BLANK ENC KEY TO DEVICE  

-10044 SET SESSION CIPHER TEXT BLANK ENC KEY FROM DEVICE  

-10045 SET SESSION CIPHER TEXT BLANK SIGN KEY TO DEVICE  

-10046 SET SESSION CIPHER TEXT BLANK SIGN KEY FROM DEVICE  

-10047 SET SESSION KEY MISSING CP RSA KEY  

-10048 SET SESSION CP RSA MOD BASE64 DECODE FAILED  

-10049 SET SESSION CP RSA EXP BASE64 DECODE FAILED  

-10050 SET SESSION CP RSA KEY INIT FAILED  

-10051 SET SESSION CP RSA MOD CREATION FAILED  

-10052 SET SESSION CP RSA EXP CREATION FAILED  

-10053 SET SESSION MISSING SIGNATURE  

-10054 SET SESSION SIGNATURE HASH FAILED  

-10055 SET SESSION MISSING SIGNATURE VALUE  

-10056 SET SESSION SIGNATURE VALUE BASE64 DECODE FAILED  

-10057 SET SESSION SIGNATURE VERIFICATION FAILED  

-10058 MISSING SEQUENCE BASE  

-10059 INVALID SEQUENCE BASE  

-10060 EXPIRE SESSION PARSE ERROR  

-10061 EXPIRE SESSION SESSION NOT FOUND  

-10062 VERIFY HMAC SIGNATURE VALUE BASE64 DECODE FAILED  

-10063 VERIFY HMAC MISSING SIGNATURE  

-10064 VERIFY HMAC PROCESS FAILED  

-10065 VERIFY HMAC SIGNATURE FAILED  

-10066 VERIFY UPNP SECURITY INFO INVALID SEQUENCE NUMBER  

-10067 DECRYPT AND EXECUTE SESSION DOES NOT EXIST  

-10068 DECRYPT AND EXECUTE MISSING REQUEST TAG  

-10069 DECRYPT AND EXECUTE MISSING IN IV  

-10070 DECRYPT AND EXECUTE BASE64 DECODE FAILED  
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System Errors 
Number Error Message 

-10071 DECRYPT AND EXECUTE EXPIRED SESSION  

-10072 DECRYPT AND EXECUTE SET IV FAILED  

-10073 DECRYPT AND EXECUTE DECRYPTION FAILED  

-10074 DECRYPT AND EXECUTE IV BASE 64 DECODE FAILED  

-10001 SSL DECODING LENGTHS FAILED  

-10002 SSL DECODING PMOD FAILED  

-10003 SSL DECODING PEXP FAILED  

-10004 SSL DECODING PRI EXP FAILED  

-10005 SSL DECODING PRI P FAILED  

-10006 SSL DECODING PRI Q FAILED  

-10007 SSL DECODING PRI X1 FAILED  

-10008 SSL DECODING PRI X2 FAILED  

-10009 SSL DECODING PRI COEFF FAILED  

-10010 SSL DECODING CERT FAILED  

-10011 SSL REQUEST NOT AUTHENTICATED  

-10026 SECURE SESSION DOES NOT EXIST a secure session was requested 
that does not exist 

-10027 SECURE SESSIONS EXHAUSTED no more secure sessions available 

-10100 AUTHENTICATION UPNP SECURITY NOT VERIFIED  

-10101 AUTHENTICATION UNSUPPORTED UID LEN  

-10102 AUTHENTICATION UNSUPPORTED PWD LEN  

-10103 AUTHENTICATION USER ID DOES NOT EXIST  

-10104 AUTHENTICATION USER ID PWD NOT PRESENT  

-10105 AUTHENTICATION WRONG PASSWORD  

-10106 AUTHENTICATION FAILED  

-10107 COULD NOT DECODE THE AUTHETICATION HEADER  

-11000 SECURITY INITIALIZATION FAILED  

-12000 TIMED OUT WAITING FOR CRITICAL SECION  

-12001 ERROR LEAVING CRITICAL SECTION NOT OWNED  

-12002 BULK KEY ENCRYPTION FAILED CFB START  

-12003 BULK KEY ENCRYPTION FAILED ENCRYPT  

-13000 CONTENT LEN NOT EQUAL TO HEADER CONTENT LEN  

-14001 XML MALFORMED TAG @05 

-14002 XML MALFORMED END TAG @05 

-14003 XML NO START TAG @05 

-14004 XML NO TAG NAME @05 

-14005 XML START END NAME MISMATCH @05 

-20000 MALFORMED UPNP HEADERS  

-30000 COMPRESSION INIT FAILED  

-40000 SCHEDULE SAVE NODE INDEX NOT FOUND  

-40001 DECOMPRESS GLOBAL SCHEDULE FAILED  

-40003 DECOMPRESS NOTIFICATIONS CONFIGURATION FAILED  

-50000 MAIL SERVER CONNECT ERROR  
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System Errors 
Number Error Message 

-50001 SMTP SERVER FAILURE  

-50005 MAIL SERVER CONNECT ERROR  

-50006 MAIL SERVER CONNECT ERROR  

-50007 MAIL SERVER NO HOST PARAM  

-50008 MAIL SERVER NO PORT PARAM  

-50009 MAIL SERVER NO PATH */ 

-50010 MAIL SERVER DNS ERROR  

-50011 MAIL MAX FROM LEN  

-50012 MAIL MAX SUBJECT LEN  

-50013 MAIL MAX TO LEN  

-60000 NTP CONFIG SERVER NO HOST PARAM  

-60001 NTP CONFIG SERVER ADDRESS RESOLUTION FAILED  

-60002 NTP CONFIG SERVER NO INTERVAL PARAM  

-60004 NTP SERVER ADDRESS RESOLUTION FAILED  

-60006 NTP SERVER NOT RESPONDING  

-60007 NTP SERVER CONNECT ERROR  

-70000 OUT OF MEMORY  

-70001 VECTOR MAX CAPCITY  

-80000 IGD FAILED PARSING DESCRIPTION URL  

-80001 IGD FAILED RETRIEVING DESCRIPTION FILE  

-80002 IGD FAILED RETRIEVING URL BASE  

-80003 IGD FAILED PARSING URL BASE  

-80004 IGD FAILED RETRIEVING WAN CONNECTION DEVICE  

-80005 IGD FAILED RETRIEVING CONTROL URL  

-80006 IGD FAILED PARSING CONTROL URL  

-80007 IGD FAILED RETRIEVING EXTERNAL IP  

-80008 IGD NO RESPONSE FROM GATEWAY  

-80009 IGD FAILED STRIPPING HTTP HEADERS  

-80010 IGD FAILED DELETING PORT FORWARD MAP  

-80011 IGD FAILED ADDING PORT FORWARD MAP  

-80012 IGD FAILED GETTING SPECIFIC ENTRY  

-90001 CRC INVALID ORDER  

-90002 CRC INVALID POLYNOM  

-90003 CRC INVALID CRC INIT  

-90004 CRC INVALID CRC XOR  

-100000 LOGGER DIRECTORY CREATION FAILED  

-100001 LOGGER SD IS NOT INSTALLED  

-100002 LOGGER LOG FILE OPEN FAILED  

-100003 LOGGER TEMP LOG FILE OPEN FAILED  

-100004 LOGGER MAKE ROOM LOG FILE OPEN FAILED  

-100005 LOGGER SEEK FREE LOG SIZE FAILED  

-100006 LOGGER SEEK END OF LINE FAILED  

-100007 LOGGER TEMP LOG FILE READ FAILED  
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System Errors 
Number Error Message 

-100008 LOGGER TEMP LOG FILE WRITE FAILED  

-110000 FILE TO STRING OPEN FAILED  

-110001 FILE TO STRING MEM ALLOC FAILED  

-110002 SD DRIVE FORMAT FAILED 1 format failed 

-110003 SD DRIVE FORMAT FAILED 2 couldn't write the config.ud file 

-110004 SD DRIVE MOUNT FAILED 1 mount after format failed 

-110005 SD DRIVE MOUNT FAILED 2 initial mount failed 

-110006 SEND FILE OPEN FAILED  

-110007 SEND FILE READ FAILED  

-110008 RECEIVE FILE WRITE FAILED  

-110009 RECEIVE FILE OPEN FAILED  

-110010 SD DRIVE DIRECTORY CREATION FAILED  

-110011 SD DRIVE CONFIG FILE OPEN WRITE FAILED  

-110012 SD DRIVE CONFIG FILE OPEN READ FAILED  

-110013 SD DRIVE CONFIG WRITE FAILED  

-110014 SD DRIVE CONFIG READ FAILED  

-110015 STRING TO FILE OPEN FAILED  

-110016 STRING TO FILE WRITE FAILED  

-110017 FILE TO STRING READ FAILED  

-110018 REMOVE FILE FAILED  

-110019 REMOVE DIR FAILED  

-110020 FLUSH FILE FAILED  

-110021 CLOSE FILE FAILED  

-110022 OPEN FILE FAILED  

-110023 FLUSH FILE SYSTEM FAILED  

-110024 FILESYSTEM_INIT_FAILED  

-120000 FIRMWARE UPDATE OPEN FILE FAILED  

-120001 FIRMWARE UPDATE HEADER READ FAILED  

-120002 FIRMWARE UPDATE CHECKSUM FAILED  

-120003 FIRMWARE UPDATE MALLOC FAILED  

-120004 FIRMWARE UPDATE DATA READ FAILED  

-130000 ELK CONFIG PARSER ERROR  

-140000 HTTP_CLIENT_DNS_ERROR  

-140001 HTTP_CLIENT_BASE64_ENCRYPTION_FAILED  

-140002 HTTP_CLIENT_CONNECTION_TIMED_OUT  

-140003 HTTP_CLIENT_WRITE_HEADER_FAILED  

-140004 HTTP_CLIENT_WRITE_BODY_FAILED  

-140005 HTTP_CLIENT_READ_RESPONSE_FAILED  

-140006 HTTP_CLIENT_HEADER_NO_STATUS  

-140007 HTTP_CLIENT_RESOURCE_MOVED  

-140008 HTTP_CLIENT_REQUEST_FAILED  

-150000 TCP_CLIENT_WRITE_FAILED  

-150100 UDP CLIENT DNS ERROR  
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System Errors 
Number Error Message 

-160000 PROTOCOL_READER_READ_ERROR  

-160001 PROTOCOL_READER_BUFFER_OVERFLOW  

-160002 PROTOCOL_READER_REOPEN_ERROR  

-170000 WEB_MODULE_NO_FREE_SPACE  

-200000 DRIVER  

Web Services/SOAP Errors 

Web Services/SOAP Errors 
Number Error Message 

200 SOAP OK Request Succeeded 

401 Invalid Action The HTTP Action header (SOAPAction) is invalid 

402 Invalid Arguments  

500 Internal Error  

501 SOAP Action Failed Could not process the request SOAP message 

600 Invalid Argument Value 
Was expecting a different value for the given 
argument 

601 Argument Value Out of Range  

602 Not Implemented 
Returned when given SOAP Request is not 
implemented 

603 Out of Memory ISY is out of memory and might require reboot 

604 Human Intervention Required  

605 String Argument Is Too Long  

609 Not Encrypted Not used in 2.6.1 and above 

612 Invalid Session Not used in 2.6.1 and above 

701 Not Authorized Credentials are either wrong or not provided 

711 Signature Failed Not used in 2.6.1 and above 

712 Signature Missing Not used in 2.6.1 and above 

714 Invalid Sequence Not used in 2.6.1 and above 

715 Invalid Control URL 
Control URL is the location where SOAP 
messages are Posted to 

721 Algorithm Not Supported Not used in 2.6.1 and above 

781 No Such Session The requested session does not exist 

801 Exhausted Secure Sessions 
No more sessions are available. In some cases, 
this may require reboot 

802 Device Error Could not communicate with a device 

803 Is In Linking Mode 
When ISY is in Linking mode, most other 
operations fail returning this code 

810 Subscription: Incompatible Headers 
Subscriptions require headers as defined in the 
developers guide 

811 Subscription: Missing Callback 
Need CALLBACK: URL in the HTTP Header. <URL> 
could be <REUSE_SOCKET> 
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Web Services/SOAP Errors 
Number Error Message 

812 Invalid NT Not used in 2.6.1 and above 

813 Subscription: SID Not Found The Subscription for the given SID does not exist 

814 Subscription: Invalid Callback URL 
If <REUSE_SOCKET> is not used, the URL is 
pointing to a destination that is not reachable 

815 Subscription: MAX Subscribers Reached You can no longer subscribe 

816 Disclaimer not available You may ignore this error 

817 Subscription: Already subscribed 
You are already subscribed and there's no need 
to subscribe again 

SMTP Errors 

The following email errors are enumerated in the Control field (column 2) and are related 
to Error -50001 (SMTP_SERVER_FAILURE). 

SMTP Errors 
Number Error 

-2 NETWORK_ERROR 

-5 SMTP_CONNECT_FAILED 

-6 SMTP_SERVER_NOT_RESPONDING 

-7 SMTP_EHLO_TIMEOUT 

-10 SMTP_FROM_TIMEOUT 

-11 SMTP_TO_TIMEOUT 

-12 SMTP_DATA_TIMEOUT 

-13 SMTP_BODY_TIMEOUT 

-14 SMTP_AUTH_LOGIN_NOT_ACCEPTED 

-15 SMTP_USERID_NOT_ACCEPTED 

-16 SMTP_PASSWORD_NOT_ACCEPTED 

-17 SMTP_STARTTLS_NOT_ACCEPTED 

-18 SMTP_TLS_NEGOTIATIONS_FAILED 

-19 SMTP_WRITE_FAILED 

-20 SMTP_UNSUPPORTED_AUTH_METHOD 
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Driver Errors 

The following sub errors are enumerated in the Control field (column 2) and are related to 
errors -200xxx. 

Driver Errors 
Number Error 

-1 Failed writing the highwater mark 

-2 Failed writing PLM slave link 

-3 Failed writing PLM master link 

-4 Failed reading device memory 

-41 Failed writing device memory 

-5 Failed reading device link 

-51 Failed writing device link 

-6 Failed restoring device from file 

-7 Failed initializing node - continuing 

-8 Node not added - failed reading links 

-9 Node not added - failed removing links 

-10 Node not added - failed restoring device 

-11 Replace device incomplete 

-12 Add device incomplete 

-13 Remove device incomplete 

 


